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Introduction
CallAudit is a Microsoft Windows compatible software program that audits incoming telephone calls by 
using your computer hardware.      CallAudit provides caller information, both number and name, for 
incoming telephone calls using Caller ID.    Caller ID is a service provided by the telephone company    to
give you information on the identification of persons calling your telephone number.    When your 
telephone rings, the Caller ID information is supplied as a series of special codes between the first and 
second rings.    Although Caller ID is available in most all states and areas, it is an additional service that
must be purchased from your local telephone company.    

CallAudit uses a MODEM or serial device attached to your computer to obtain Caller ID information 
supplied by your telephone company.    When an incoming call occurs, a new call item is added to the 
Incoming Calls window.    The new line of data shows the time and date of the call, and when available, 
the Caller ID information.    CallAudit includes a relational database where all call information is stored.    
This database includes areas for your most recent calls, all past calls, and a telephone number area in 
which you can insert additional information about your callers.

The primary features of CallAudit include:

· Audit incoming calls
· Audit outgoing calls made using CallAudit
· Display Caller ID information for all calls 
· Complete history of all calls received or made
· Telephone number database including sound and Notepad data
· Ability to place calls using the MODEM dial out features
· Speed dial list for quick access to frequent calls
· Audio prompts for key program events
· Report generation from the CallAudit database
· Import/Export capability
· Complete printing support

CallAudit is bundled in a variety of forms and versions for different types of Caller ID 
capable hardware.    The features and capabilities of the different CallAudit versions are 
highlighted in the CallAudit Versions help section.



Caller ID Service
Caller ID is a telephone company service to provide information on the identification of persons calling 
your telephone number.    When someone calls your number, your telephone begins to ring.    The Caller 
ID information is provided by the telephone company as a series of special codes between the first and 
second rings.    The information includes the time and date of the call, the telephone number of the caller
(see below for exceptions), and depending on your Caller ID service, additional data in some areas.    

CallAudit uses this Caller ID information to provide detailed information on your incoming calls.    
Without Caller ID from your telephone company CallAudit cannot determine the telephone number 
of incoming calls.    

CallAudit also requires the use of a MODEM or other serial device that supports Caller ID.    If your
MODEM or serial device does not support Caller ID, then the caller identification information supplied by
the telephone company will not be available to the CallAudit software.

In some areas the telephone company provides what is called Caller ID+ or Caller ID name service.    In 
these areas both the telephone number and name of the calling party are supplied.    CallAudit software 
is compatible with Caller ID+ service and can use the name information supplied if your telephone 
company and MODEM hardware support it.

Note:    Recent FCC changes have resulted in the implementation of Nationwide Caller ID in most 
areas of the US.    Each telephone company is handing the Caller ID name somewhat differently.    
Some telephone companies will send the true name of the caller as if it were a local caller.    Other 
telephone companies will send the City and State (separated by a comma) of the caller in the name 
field.    Contact your local telephone company to see how this is handled for your area.

Caller ID information is provided by the telephone company in two different formats.    
Single Message Format is the simplest and is supported by all Caller ID capable MODEMs 
and devices.    Multiple Message Format, which is considerably more complicated. is used to
supply additional Caller ID information such as caller name identification.    Multiple 
Message Format is not supported by all hardware vendor MODEM products.    If your 
telephone company uses Multiple Message Format data, contact your MODEM 
manufacturer to determine if your hardware can support this standard.
Included in Appendix A is a list of the current known vendor devices that CallAudit can support.    In 
general, many current MODEM products that support the Rockwell MODEM standards will support 
Caller ID.    Other serial devices also support Caller ID in different ways.    See chapter 7.0 for more 
details on configuring you MODEM or serial device for use with CallAudit.
Each telephone company has an area in which they support Caller ID.    The extent of this area varies 
with each local telephone company.    In some cases this may be multiple states, and in other cases only
your local area.    If you receive a call from someone from out of the calling area supported by your 
telephone company, the Caller ID software will indicate Out of Area. If you receive a call from someone 
what has their Caller ID information blocked, then you will receive only an indication that the caller is 
Private.    See the Private and Out Of Area Calls section for more information about Private 
and Out of Area calls.
Different hardware and MODEM manufacturers provide products that can detect these codes and 
provide Caller ID information to the user.    Although Caller ID is available in most all states and areas, it 
is an additional service that must be purchased from the telephone company.    If you do not purchase 
this additional service, CallAudit will not be able to detect any Caller ID information.



Installation And Setup
System/Hardware Requirements
CallAudit is a software application that installs in your PC compatible computer.    It uses a MODEM or 
other serial device in your computer to audit incoming telephone calls.

To use CallAudit you need the following :

· IBM-compatible personal computer with an 80386 or higher processor (including 80386SX).
· Hard disk with 1.5 megabytes of free space.
· Mouse or other compatible pointing device.
· EGA, VGA, or compatible display. (VGA or higher is recommended.)
· Four megabytes of random-access memory.    (Six megabytes or more is recommended.)
· MS-DOS® version 5.0 or later, and Microsoft Windows version 3.1 or later.
· Caller ID capable MODEM or serial device connected to your telephone line
· Caller ID service from your telephone company

Other optional items include :

· Second MODEM for multiple telephone line support
· Microsoft windows compatible sound board and connected speakers

CallAudit has been tested successfully with Microsoft Windows 3.1, Microsoft Windows 3.11, Microsoft 
Windows for Workgroups 3.11, Windows 95, and Windows NT.

Setting Up and Starting CallAudit

Use the Setup program (SETUP.EXE) to install CallAudit on your computer.

Use the following steps to set up CallAudit:

1. Start Microsoft Windows
1. Insert Disk 1
2. In the Windows Program Manager (or Explorer), choose the File menu
3. Choose Run menu option
4. Type a:\setup and press enter
5. Choose the OK button
6. Follow the instructions on the screen

During setup you will be prompted for user registration information and the software destination 
directory.    The destination directory determines where on your supported hard disk(s) CallAudit will be 
installed.    The default setting is C:\CALAUDIT which is satisfactory for most installations.    You may 
change this location to either a different disk volume or destination directory name.

The CallAudit installation includes the basic software product (CALAUD32.EXE), a set of sound files (in 
the form of xxx.WAV) for use in sound prompts for telephone events, the initial CallAudit database 
(CALAUD32.MDB), and a number of Dynamic-link libraries (DLLs) that are required for program 
operation.    Some of these DLLs will be installed in your Windows System directory, and others in the 
CallAudit directory.

If this installation is an update to your existing CallAudit software, a database conversion program will 
also automatically convert any existing data the first time you execute CallAudit.    See the Database 
Conversion section for more information on this topic.

At the completion of CallAudit setup a new program manager group will be created.    This will include 
icons for CallAudit startup, Help, and a RELNOTES.TXT file with the latest information for the product.

CallAudit uses a relational database (CALAUD32.MDB) to store incoming and outgoing call information. 
The default installation for this database is for shared access by multiple users and/or programs.    This 
means that two or more programs or users can access the database at the same time.    The CallAudit 
database software manages updates by locking portions of the database while updates are being 



processed.      This prevents two users or programs from trying to update the same portion of the 
database at the same time. 

The CallAudit software requires a sufficient number of DOS file locks to perform this task.    If you use 
Microsoft Windows for Workgroups (version 3.11 or later), this process is handled automatically for you.  
If you use Windows 3.1 you may have to make changes to your AUTOEXEC.BAT or CONFIG.SYS file. 
Microsoft Windows 3.1 should review the next section for these details.

Microsoft Windows 3.1 Users

The DOS program SHARE.EXE is loaded at boot time and determines the number of shared file locks 
available to the system.    SHARE.EXE can be loaded either in the AUTOEXEC.BAT file or the 
CONFIG.SYS file. In either case the number of locks should be set to at least a value of 100 locks.    You
should be sure this line is in one of your system files.    Included below is an example of the line that 
needs to be added or edited for each of these system files.    Additional information can be obtained 
about the SHARE.EXE program by using the DOS command    HELP SHARE.

AUTOEXEC.BAT should contain a line like the following:

C:\DOS\SHARE.EXE      /L:100

or CONFIG.SYS should contain a line like the following:

INSTALL=C:\DOS\SHARE.EXE      /L:100

Note:    ONLY ONE OF THESE SYSTEM FILES should be modified to include the SHARE.EXE 
program.    If both files are modified system problems will result.

Configuring Disk Cache
CallAudit uses the Microsoft Open Data Base Connectivity (ODBC) standards for all 
database software support .    Any time a database update occurs (such as a telephone 
number update, processing during an incoming call, or adding a telephone number to the 
speed dial set) CallAudit makes calls to ODBC software.    ODBC uses a significant amount of
disk input/output to perform its functions.    
ODBC software runs slow on many systems that have little or no disk cache defined.    The 
DOS program SMARTDRV.EXE is used on many standard Windows systems to configure and 
manage cache memory.    For example a system with little or no cache memory defined, 
may require as much as 10-12 seconds to add a telephone number to the CallAudit speed 
dial list.    The same system will only take 1-2 seconds for the same operation when the 
cache memory is defined.
If you are running Windows for Workgroups, use the Control Panel Enhanced 386 section to 
define and configure cache memory for your system.    If you are running Windows 3.1, add 
a line like the following to your AUTOEXEC.BAT file.

C:\DOS\SMARTDRV /V 1024 1024
The first number determines the amount of your RAM memory used for a memory cache 
while only DOS is running.    The second number is the amount of RAM used when Windows 
is running.    Consult your DOS help system for more information about SMARTDRV.EXE and 
other parameters that you may wish to use.
To start CallAudit

1. In the Windows Program Manager, open the program group that contains the CallAudit icon.
2. Double-click the CallAudit icon.
3. CallAudit starts and displays the main window.

When you use CallAudit for the first time the following display will appear.



Follow the instructions on the screen to select a MODEM type and COM port.    An available list of 
devices is provided as well as the list of COM ports for your PC.

A standard setup string is automatically provided for each MODEM type.    This default setup string is 
usually all that is needed.    Make changes to this string ONLY if you know your changes WILL work, and
if the changes are necessary.

CallAudit cannot audit incoming or outgoing telephone calls unless a supported MODEM or serial device
is selected.

For more details on startup options, choose Search from the Help menu for CallAudit and search for 
“starting CallAudit.”

To quit CallAudit

· From the File menu, choose Exit, or
· Press the Exit button on the main menu bar



Program Operation Overview
CallAudit includes a main window area and a number of related child windows.    An example of the main
window is shown below.    

The main window area includes a menu bar for selection of program options, a button bar for quick 
selection of key program functions, a central display area that will contain most of the other child 
windows, and a status bar at the bottom.

The central display area can include one or more child windows.    Examples of child windows are the 
Incoming Calls Display, the Outgoing Calls Display, or the Phone Book.      See the Help Contents for a 
complete listing of child windows.

Only one child window is active at a time.    The top most child window is always the active window.    

The menu bar includes one or more pull-down menus based on the active child window.    The File and 
Help pull-down menus are common to all child windows.    The number of pull-down menus present, and 
the contents of each, changes with the active child window. 

Each of the basic window displays may be selected by either choosing an appropriate menu option or 
pressing one of the button bar buttons.    For example, the Outgoing Calls display can be obtained by 
simply pressing the red Outgoing button on the button bar.    The function of each of the button bar items 
is summarized below:

Brings Incoming Calls display to front.

Start Outgoing Calls display.    Bring to front if already started.



View Call Notes for the selected call record.

See database record details for a single telephone number.

Start Phone Book display.    Bring to front if already started.

Start Dial Out display.    Bring to front if already started.

Start Generate Reports display.    Bring to front if already started.

Edit System Preferences.    Bring to front if already started.

Generate Calendar display.    Call date is shown if incoming or outgoing call is selected, otherwise 
today’s date is shown.

Obtain Help on CallAudit for the current display.    

Exit CallAudit.

Program help is available at any time.    A Help pull-down menu is always available with a number of help
options.    The question mark button on the button bar can be used to provide help about the current 
active child window.    The F1 function key can be used to provide help on the current active window.    
Many child windows also provide a specific Help push-button, which can provide further help 
information.

The size and location of the main window display, and most of the child windows, can be changed by the
user.    When you exit CallAudit, it keeps a record of the last size and location of each window.    The next
time the CallAudit program starts it will return to the size and locations saved.    Additional options exist 
for the automatic main window size adjustment and are covered in the Display Defaults portion of the 
System Preferences section.

The normal child window displayed in the main window area is the Incoming Calls window.    This display
provides a summary of all incoming calls including date/time, calling number, and name of the caller.    
As each incoming call occurs, a new summary line is added to this display.    See the Incoming Calls 
Display section for more details on this display.    

The time, date, and number information are provided automatically by the CallAudit software based on 
the Caller ID information from the telephone company.    The name information is provided based on 
information you insert into a phone book database included with the product.    The option exists to have 
a Caller ID name supplied by the telephone company appear here if you have Caller ID name service.

The status bar portion (bottom area) of the main window display includes a status message area on the 
left and a time/date area on the right.    The status message area provides a one line summary of the 



current state of the CallAudit system.    Examples of messages displayed in this area include:

Telephone Line is Idle 

Default message after CallAudit starts.    This indicates that CallAudit initialized without errors and 
is awaiting events on the incoming telephone lines to audit.

Telephone line is NOT audited
Error message after CallAudit starts.    This indicates that CallAudit initialized with errors and is not 
able to audit incoming calls on the telephone line.

Telephone is Ringing
Message displayed when an incoming call begins.    This message will be updated to reflect the 
number and name of the caller when the Caller ID data arrives between the first and second rings.

“Dial Out messages”
A series of messages that shows the status events when placing outgoing calls.    An example is 
“Placing outgoing call to XXX-XXXX”.

“Menu Selection messages”
When a menu item is selected with the mouse, a one line summary of the action of that item is 
displayed.    For example if the “By Day” item from the View menu is selected with the mouse, the 
status bar will show “View calls for the current day”.

“Database Event messages”
CallAudit stores all of the incoming and outgoing call information in the CallAudit database.    When 
database updates are being made, a one line summary will be displayed to indicate the area being 
updated.    For example when placing an outgoing call the status line will initially change to 
“Updating call history database” to indicate that the software is making a permanent record of this 
outgoing call.    A similar set of messages are displayed during the incoming call process to record 
the call.

The Incoming Call Process
When an incoming call occurs, the following processes and steps are performed:

· A new summary line is added to the Incoming Calls display
· Incoming call audible alert is spoken
· Caller ID codes arrive between first and second rings
· Caller ID info is updated in Incoming Calls display
· Caller phone number or name is spoken
· CallAudit database is updated to reflect the new call

You can alter many aspects of this process using the System Preferences display screens.    The above 
represents the normal setting for an incoming call.    The following options also exist.

· The database details screen for this caller can be displayed
· The Notepad data for this caller can be displayed
· CallAudit can come to the foreground in Windows
· Audible alerts and spoken phrases can be turned on/off
· The program can run in icon mode and display a pop-up call summary
· Caller ID name service can be enabled
· The Incoming Calls can be sorted and displayed using different criteria

The System Preferences section covers the details of these options as well as the other features of the 
software.

How Calls Are Audited and Stored
CallAudit uses your MODEM or other supported serial device to audit incoming calls and place outgoing 
calls.    All CallAudit information is stored in a relational database included with the product.    The 



database is divided into tables that store related pieces of information.    

A phone number table stores information about each of the telephone numbers known to the system.    A
call history table stores information on all calls, both incoming and outgoing, made since the program 
was installed.    A current calls table stores information about your most recent calls (which are displayed
in the Incoming and Outgoing Calls displays).    A MODEM database contains information about the 
technical characteristics of each of the support hardware devices for CallAudit.    A speed dial table 
stores information about the telephone numbers you use with the speed dial option on the Dial Out 
display.

An important distinction in CallAudit is the difference between the call history table and the current calls 
table.

The call history includes an entry for each incoming or outgoing call made since the CallAudit program 
was installed.    The number of entries in this table can be very large and is only limited by the hard disk 
space on your system.    Entries in this table can be deleted, if desired, using the delete record option 
described in the Generate Reports section.

The current calls table only includes records for the Incoming Calls and Outgoing Calls lists.    The data 
for these displays is managed directly inside Windows memory area to provide fast performance for 
small size lists.    The size of each of these displays is limited to a maximum of 500 calls each. This 
limitation is included to avoid slow program operation caused by a large number of    current calls.    You 
can further reduce the maximum number of entries using the System Preferences displays.    When the 
list size is reached, the oldest call record is deleted to make room for the new record.

A number of program options exist using the View pull-down menu to sort the actual current calls 
displayed.    You can display only the calls that occurred today, or the last week (actually the last seven 
days), or this month, or this year, or all calls.    The text area on the call window provides a summary of 
the total current calls and the number displayed using the select view option.    You can sort the calls in 
ascending or descending order of call time, by number, or by name.

After you have reviewed the incoming or outgoing details on older calls, you should delete them from 
these displays.    If you don’t delete them, and the maximum size limit is reached, CallAudit will 
automatically delete the oldest call from the list.    It is important to note that even when calls are deleted 
from this display, the call information is still stored in the call history table.    You obtain information about 
your call history records by using the Generate Reports option.    The Reports area can also be used to 
make permanent deletion to the call history records.      

When an incoming call occurs, CallAudit obtains the telephone number information from the Caller ID 
information supplied by your telephone company. The Caller ID information is provided by the telephone 
company as a series of special codes between the first and second rings.    Your MODEM or serial 
devices passes this data to the CallAudit software.    

CallAudit then looks that number up in your phone book to see what name, if any you have entered for 
this number.    If the number exists, and you have supplied a name, then this name information is 
displayed in the Incoming Calls summary window.    If the number exists, and you have not yet entered a
name, then “Unknown” is displayed as the caller name.    If no phone record exists for this telephone 
number, then a new record is automatically added to your database.    As each new caller telephones 
your system, their phone number is automatically added to your database.    

CallAudit also has the option to use Caller ID name service.    Caller ID name service is also provided by 
the telephone company and provides the caller’s name as well as the caller’s number.    When this 
option is selected, the Caller ID name supplied by the telephone will be displayed in the Incoming Calls 
display.

For each new incoming call, a record is added to your current calls table and a record to your call history
table.    These entries can be used later to generate call reports or to determine when a specific number 
called your line.

The same process is used for outgoing calls.    Each call you make with CallAudit is entered in the 
Outgoing Calls display.    A corresponding entry is made in the current calls table and call history table in 



the database.

Other Program Displays
CallAudit includes child windows for the following related displays:

· Incoming Calls which tracks incoming calls
· Incoming Call Details which provides more information on a single incoming call
· Outgoing Calls which tracks outgoing calls made through CallAudit
· Outgoing Call Details which provides more information on a single outgoing call
· Phone Book which provides a sorted list of all names and telephone numbers
· Telephone Number Details which provides all information for each number
· Dial Out which is used to place outgoing calls
· Call Reports which is used to generate reports on past calls and numbers
· System Preferences which is used to set different program options
· Import Phone Numbers which is used to import telephone numbers
· Message Box which is used for status messages
· Calendar which shows the current month in a calendar format

Each of these displays is described in sections to follow.

Getting Program Help
CallAudit includes a complete Window help facility.    You can press the F1 function key at any time to 
receive help on the current function or window.    The question mark button on the main window display 
will always provide a help summary on the current active child window.    Many of the child windows also 
include a separate Help button that can provide further information on the particular display function.



CallAudit Software Versions
CallAudit is bundled in a variety of forms and versions for different types of Caller ID 
capable hardware.    The current versions of CallAudit include:

CallAudit 2.1
CallAudit 2.1 is the standard software package that supports a wide variety of single 
line Caller ID capable MODEMs and serial devices.

CallAudit MultiLine 2.1
CallAudit MultiLine 2.1 is the multiple line software package that supports a wide 
variety of multiple line Caller ID hardware. CallAudit MultiLine 2.1 includes all the 
features of the standard product plus the ability to audit up to 65 separate telephone 
lines.
    

CallAudit Version 3.0 for Windows 95
CallAudit Version 3.0 for Windows 95 is the newest offering from Mountain Systems.    
CallAudit 3.0 is a full 32 bit application designed for Windows 95.    Version 3.0 offers 
that features from 2.1 plus many more new features including paging, TAPI support, 
and electronic mail.

CallAudit MultiLine 3.0 for Windows 95
CallAudit MultiLine 3.0 for Windows 95 is the multiple line software package that 
supports a wide variety of multiple line Caller ID hardware. CallAudit MultiLine 3.0 
includes all the features of the standard CallAudit 3.0 product plus the ability to audit 
up to 129 separate telephone lines, as well as other multiple line features.

CallAudit Routing Server 2.1
CallAudit Routing Server is a software add-on package to CallAudit MultiLine 2.1 
product.    The CallAudit Routing Server software extends the capabilities of the 
MultiLine software across network environments.    One PC acts as a call server, with 
the multiple line Caller ID hardware attached, and other client PCs on the network all 
receive the Caller ID data.

CallAudit Client 2.1
CallAudit Client is a software add-on package to CallAudit MultiLine 2.1 product.    The 
CallAudit Routing Server software extends the capabilities of the MultiLine software 
across network environments.    One PC acts as a call server, with the multiple line 
Caller ID hardware attached, and other client PCs on the network all receive the Caller 
ID data.    The CallAudit Client software runs on each client PC and provides all the 
capabilities of CallAudit MultiLine 2.1 using a network interface with the CallAudit 
Routing Server.

CallAudit Lite
CallAudit Lite is a Caller ID software package that is bundled directly with specific 
single line MODEM and serial Caller ID capable devices.    CallAudit Lite includes a 
subset of the features of the full CallAudit product.



CallAudit Demo
CallAudit Demo is a demonstration version of CallAudit.    It includes full functionality 
for demonstration purposes, but has restrictions on the number of calls, numbers, and 
records that can be processed.

CallerPROFILE Links
CallerPROFILE Links is software version that is developed for Rochelle Communications.
CallerPROFILE Links versions includes the standard product, multiple line product, and 
client and server versions.



Private and Out of Area Calls
Each telephone company has an area in which they support Caller ID.    The extent of this area varies 
with each local telephone company.    In some cases this may be multiple states, and in other cases only
your local area.    Private and Out of Area calls are special calls supported by telephone companies.

If you receive a call from someone from out of the calling area supported by your telephone company, 
the Caller ID software will indicate Out of Area. Further identification of the caller is not possible.    The 
CallAudit PhoneBook will show this number as O, which is the actual telephone number supplied by the 
telephone company for Out of Area calls.    The other CallAudit displays will show the number as Out of 
Area and the name as Unknown.

The telephone company may also provide an option to have the Caller ID information blocked.    This is 
usually a special service that can apply to all calls made by a Private caller, or on selected calls.    

If you receive a call from someone what has their Caller ID information blocked, then you will receive 
only an indication that the caller is Private. Further identification of the caller is not possible. The 
CallAudit PhoneBook will show this number as P, which is the actual telephone number supplied by the 
telephone company for Private calls. The other CallAudit displays will show the number as Private and 
the name as Unknown.
Both of the PhoneBook entries for these numbers are permanent records and cannot be deleted by the 
user.



CallAudit Version 3.0 for Windows 95 New Features
CallAudit Version 3.0 for Windows 95 is a 32 bit enhancement of the current CallAudit 2.1 
software product.  CallAudit 3.0    includes all the features of the current product with the 
following additions:

32 bit application designed for Windows 95
Integrated paging support
Microsoft Access 7.0 database format
Icon based call log displays with sort headers
Tip of the Day option
Integrated E-Mail support
TAPI Support
Option for multiple PhoneBooks
Associated telephone number support
User configurable call log display options
Windows 95 look and feel, including right mouse support
Improved database performance using
Microsoft Data Access Objects
Expanded DDE support
New database utilities

Paging Support
CallAudit can issue pages to your personal pager for both incoming and outgoing calls.    
You can tailor the pager message to include the name and number of the caller as well as 
other call information.    Messages can include up to 1024 characters.    Pages can be 
generated for all calls or for calls from selected telephone numbers. CallAudit paging 
support can work with all paging systems including both numeric and alpha-numeric 
pagers. CallAudit can work with multiple pagers at the same time.    Pages for incoming 
calls from specific numbers can go to separate pagers.

E-Mail Capabilities
CallAudit can interface with your E-Mail system in many ways. CallAudit can send E-
Mail to selected E-Mail addresses for every incoming call or from incoming calls from 
selected telephone numbers.    CallAudit can automatically check the E-Mail inbox for new 
messages.    If new messages are detected, CallAudit can prompt the user display and/or 
send a page to your pager indicating new E-Mail has arrived.    CallAudit can also 
interface directly with your E-Mail system to support composing and sending user 
directed E-Mail.

TAPI Support
CallAudit can now work with TAPI compliant hardware.    This includes inbound Caller ID, 
outbound detection, call duration, call blocking, dial out, and other TAPI features.      
CallAudit will automatically detect the features supported by the selected TAPI device and
configure the software accordingly.



Multiple PhoneBooks
CallAudit now includes support for up to 16 separate PhoneBooks.    You can view the 
telephone numbers by individual PhoneBook, or for all PhoneBooks.    The name and 
contents of each PhoneBook is set by the user.
The font for the PhoneBook display can also be set and saved.    Use the Edit menu to 
select the desired font.    When the program exits, the selected font will be saved and 
restored at the next execution.

Associated Telephone Numbers
Each telephone number has a separate database record.    The associated number option 
allows you to have a single database record for a primary telephone number, and then 
associate any number of secondary numbers with the primary number data.    Incoming 
calls will always show the number that called, but the database record displayed will be 
based on the associated primary record.    Updates to the primary or associated records 
will be reflected in all associated records.

Call Log Display Options
The incoming and outgoing call logs are now icon based.    The individual columns 
included, and the width of each column, can be set by the user.    Any column width 
changes are saved and restored at the next execution.    You can sort the call log display 
by simply clicking on the column header.
The font for call logs can also be set and saved.    Use the Edit menu to select the desired 
font.    When the program exits, the selected font will be saved and restored at the next 
execution.

Right Mouse Support
CallAudit 3.0 includes a variety of right mouse options along the line of Windows 95.    In 
the call log display, one can use the right mouse to access the database details record, 
the call details, the PhoneBook for the highlighted call record, place an outgoing call, and 
other options.    Similar capabilities are provided for the PhoneBook, Report, and other 
displays.

Tip of the Day
CallAudit 3.0 includes a Tip of the Day option to provide hints on how to better use the 
program.    You can have this start with each program execution, or call up the option at 
any time.

New Database Utilities
New database utilities have been added to help manage the CallAudit database files.    
Database compact and repair options are available from the Actions menu.    Use these 
functions to compact the size of the current database or repair the database if errors 
exists.
Use the File Database Open and Save Database As commands to backup the current 
CallAudit database or to open an existing database.



CallAudit Windows 3.X and Windows NT Differences

CallAudit Version 3.0 includes support for Windows 95, Windows NT, and Windows 3.X.    
The feature set for Windows 3.X and NT is slightly different from Windows 95.

Windows 95
CallAudit 3.0 for Windows 95 includes the full feature set with no restrictions.

Windows NT
CallAudit 3.0 for Windows 95 includes the full feature set with the exception of TAPI 
support.    Windows NT 3.51 does not currently support 32-bit TAPI.    
Microsoft has stated that Windows NT 4.0 will support TAPI.    The current Microsoft Beta 
version of NT 4.0 does support TAPI and the final products is also expected to support 
TAPI. 

Windows 3.X
CallAudit 3.0 for Windows 3.X includes a reduced feature set.    The feature changes for 
the Windows 3.X user include the following:

16-bit application for improved performance in Windows 3.X
Access 2.0 database ODBC format using dynaset access for faster performance
Call log header widths automatically adjust to font size
Call logs do not include icons
Call log sorts are done via View menu
E-Mail support requires a MAPI compliant mail system.
Right mouse support not available



Calendar
The Calendar option provides a standard monthly calendar for quick reference to dates.    The calendar 
can be displayed by using the Calendar option from the Options item on the menu bar or by pressing the 
Calendar button on the button bar.    An example of the calendar display window is shown below.

Use the left and right arrow keys to change the month.    Press the Today button to have today’s date 
displayed.

To see the calendar for a particular incoming or outgoing call date do the following:

· Select the Incoming Calls or Outgoing Calls display
· Select the desired call record with the mouse
· Press the calendar button on the button bar 

The month for the selected call will be displayed with the call day shown.



Helpful Hints
Creating a new telephone number record
Editing an existing telephone number record
Delete multiple telephone numbers
Using a MODEM not in the supported list
Rejecting incoming calls

Testing the Whozz Calling? Single Line Device

Starting CallAudit Minimized     



Editing an Existing Telephone Number Record
Each telephone number in the CallAudit database has a set of associated data fields which 
are user editable.    The Database Details section provides more information on these fields 
and how they are edited.

To edit data for a telephone number record, use one of the following procedures:

From Incoming or Outgoing Calls list
1) Identify call record from desired telephone number
2) Select the call record with the mouse
3) Press the DB Detail button on the button bar
4) Edit data as desired 

From Phone Book
1) Identify Phone Book record for desired telephone number
2) Double click the record with the mouse
3) Press the DB Detail button on the button bar
4) Edit data as desired

From Dial Out
1) Input/select desired telephone number
2) Press the DB Detail button on the button bar
3) Edit data as desired

From Generate Reports
1) Select desired report record using the mouse
2) Press the DB Detail button on the button bar
3) Edit data as desired



Creating a New Telephone Number Record
New telephone number records can be created in the following ways:

From Incoming Calls
A new telephone number record is automatically created whenever an incoming call occurs 
from a telephone number not currently in the CallAudit database.    The name and number 
information are based on the Caller ID data supplied from your telephone company.    The 
other data fields are initially filled with default values.    No user action is required to add 
the record.
    
Use the steps outlined in editing an existing telephone number record to edit a newly 
created telephone number record.

From Dial Out
A new telephone number record is automatically created whenever an outgoing call is 
placed to a telephone number not currently in the CallAudit database. All the data fields are
initially filled with default values.    No user action is required to add the record.    See the 
Dial Out    section for more details on placing outgoing calls.

Use the steps outlined in editing an existing telephone number record to edit a newly 
created telephone number record.

From Telephone Number Record Details
The Telephone Number Record Details screen displays the data for a single telephone 
number.    This display is generated by selecting a single telephone record and pressing the 
DB Detail button on the button bar.    Create a new record from the Telephone Number 
Record Details screen using the following steps:

1) Press the Clear button to clear the current record
2) Enter the new telephone number in the    Number data field.
3) Press the Update button to create the new record
4) Edit the other data fields as desired
5) Press the Update button to save entered changes

Note : When entering the telephone number in step 2, be sure to enter the entire 10 digit 
number (which includes the 3 digit area code).    Do this even for local numbers that do not 
require the area code.
The Caller ID information for incoming calls (from the telephone company) always includes 
the entire 10 digits, even for local numbers.    If you only enter the 7 digit number, CallAudit
will not find this number when searching the database.



Using a MODEM Not in the Supported List
Appendix A contains the list of MODEMs and serial devices known to support Caller ID and 
work correctly with CallAudit.    Other MODEMs not in this list may also work.    Use the steps
below to test a MODEM not included in Appendix A.

1) Review MODEM user manual to check for Caller ID compatibility
2) Determine setup string to enable Caller ID
3) Press the System Preferences button on button bar
4) Select Modems area
5) Select User Specified Type for MODEM type.
6) Enter setup string from step 2
7) Press the OK button
8) Have someone call you to see if Caller ID data appears
9) If all numbers show as “Unknown”, your MODEM may not support Caller ID

See the MODEM Defaults  and System Preferences sections for more details on MODEM 
selection and setup.



Delete Multiple Telephone Numbers
The Phone Book section describes the process of deleting a single telephone number from 
the CallAudit database.    Because the Phone Book uses a virtual list technology, it is NOT 
possible to select more than one number for deletion at a time.    

By using the features of the Generate Call Reports area, multiple numbers can be deleted 
at once.    Use the following approach to delete multiple telephone numbers from the 
database.

1) Press the Reports button on the button bar
2) Press the Customize button
3) Select Phone Number Report as the report type
4) Use the By Telephone Number and By Name fields to identify the numbers to be deleted
5) Press the Execute button to generate a phone number report
6) Confirm that ALL numbers in the report are to be deleted
7) Select the Delete Records option from the Edit menu.

All the report records will then be deleted from the database.    Note that the database 
search will be dependent on the search values for Number and Name.    For example:

) Suppose you want to delete all numbers from area code 213.    Select only the By 
Telephone Number check box and enter 213.    The report will then generate a list of all 
telephone numbers from area code 213.

) Support you want to delete all numbers that begin with 999 in your local area code of 
508.    Select only the By Telephone Number check box and enter 508999.    The report will
then generate a list of all telephone numbers from your local area code that begin with 
999 .

) Suppose you want to delete all numbers for people whose names begin with John. Select 
only the By Name check box and enter John.    The report will then generate a list of all 
telephone numbers for all people whose name begins with John.

By using a combination of the By Telephone Number and By Name search values, you can 
identify a set of records for deletion.    Note that once telephone numbers are deleted, they 
cannot be recalled.    Examine the report results carefully before selecting the Delete 
Records option from the Edit menu.



Rejecting Incoming Calls
CallAudit has the capability to reject incoming calls from selected telephone numbers.    
Rejected incoming calls will ring once and then be hung up just before the second ring.    
This option allows the user to better control what telephone numbers will be accepted for 
incoming calls.

CallAudit call reject incoming calls on a telephone number by telephone number basis.    
The program also has the option to reject incoming calls from all first time callers.    See the
Incoming Calls portion of the Database Details section for more information on rejecting 
incoming calls.    



Testing the Whozz Calling? Single Line Device
CallAudit includes a special test program to test the Whozz Calling? single line device.    The
program is called WHOZZTST.EXE and is located in the CallAudit directory.

You can use this program to validate the communications connection to the device, check 
the firmware version, and to test the Caller ID features.    See the only screen option for 
more information.



How to set up DDE
Dynamic Data Exchange (DDE) is a Windows process for two Windows programs to share data and 
information.    CallAudit 2.1 has the capability to act as a DDE client and communicate with other DDE 
servers.    When an incoming or outgoing call occurs, CallAudit can use DDE to notify the other program 
about the number and name of the calling/called party.    

The most common use of this feature is bring up contact records in a Contact Manager such as ACT! 
based on an incoming call processed by CallAudit. See the DDE Support section for more overview 
information about CallAudit support for Dynamic Data Exchange.

The basic steps in setting up DDE with CallAudit are as follows:
a. Select Enable DDE from the DDE section of the System Preferences.
b. Press the Configure DDE Options button.
c. Select your desired program from the DDE program selection list.
d. Verify and/or correct as necessary the path to your program’s directory.
e. Press the second Browse button to select your program’s database file.
f. Move to the Incoming Calls tabbed section.
g. Press the Open Examples button and select the DDE file for the selected program 

from the CallAudit directory.
h. Edit the FILE_OPEN line to include the correct path and file name for your programs 

database (this step is only required for some programs).
I. Press the OK button in DDE Program Interfaces Options.    
j. Press the OK button in System Preferences.
k. Exit CallAudit to save all changes.

See the DDE Defaults section of the System Preferences section for more information on configuring 
CallAudit to support DDE.    See the DDE Application Selection section for information on the selection of
the DDE application program to be used.    See the DDE Incoming Actions section for information on 
actions to be performed for each incoming call.    See the DDE Outgoing Actions section for information 
on actions to be performed for each outgoing call.    



Starting CallAudit Minimized
CallAudit can be set to start in a minimized (running as an icon) form.    This can be useful 
when CallAudit is automatically started as part of Windows startup.    To have CallAudit start
minimized, do the following:

1. Start CallAudit
2. Minimize CallAudit
3. Close CallAudit while minimized.

Step (3) is done by selecting the CallAudit icon with the mouse, and then choosing the 
Close menu option.

The next time CallAudit starts it will initialize and then return to minimized form.    The key 
point to remember is that CallAudit, and all of it’s associated windows, always return to the 
state they were in when the program or window last exited or closed.    This is true for 
window size, window location, and window display form (normal, minimized, or maximized).



Appendix A - Supported MODEMs
Included below is the current list of MODEMs and serial devices supported by CallAudit for the detection
of Caller ID information.    If your MODEM or device is not on this list, or does not support Caller ID, then 
Caller ID information for incoming calls cannot be processed by CallAudit. Devices that do not support 
Caller ID will always show Unknown as the telephone number for all incoming calls.
Any MODEM or serial devices used to audit an incoming line must be Caller ID capable.    See the Caller
ID Service section for more details on Caller ID.

Allied Electronics OMNI COMM 400 System
BBS Telecom IPS308 Phone System
BBS Telecom IPS416 Phone System
Best Data Products Smart One 1442VLX
Best Data Products Smart One 2834FLX
Best Data Products Smart One 2834VLX
Boca FDV 14i
Boca FDVV 14i
Boca Office Commander
Boca Office Commander DSVD
Boca Sound Expression 14.4SRS
Boca Sound Expression 28.8SI/D
Boca Sound Expression 28.8SRS
CallAudit Client Operation Mode
Cardinal MVP 144IV    Internal Voice/Fax Modem
Cardinal MVP 144XV    External Voice/Fax Modem
Cardinal Technologies MVP288IV Internal
Cardinal Technologies MVP288XV External
Complete Communicator Gold
Creative Labs Phone Blaster
Dallas Fax 2496C    MODEM
Dallas Fax 2496VC Voice MODEM
Diamond Multimedia Systems TeleCommander 3500XL
E-Tech Bullet 100 E 28.8    V.34
E-Tech P192MX Bullit MODEM External
Gateway Telepath II Caller ID 14.4 MODEM
Generic Style MODEM 1200
Generic Style MODEM 14400
Generic Style MODEM 28800
Generic Style MODEM 300
GPS Caller ID Plug
Hayes Optima 144 Business
Hayes Optima 288 Business
IBM Corp. Multimedia 13H6715
J-Mark Computer A1428VQH34V
Logicode Quicktel 2814XV External
Logicode Technology 1414HV
Logicode Technology 1414XV
Logicode Technology 14V14HV
Logicode Technology 14V14PC
Logicode Technology 14V14XV
Logicode Technology 2814HV
Logicode Technology 28V14HV
Logicode Technology 28V14XV



Motorola ISG HMTA200 Hybrid Modem
Motorola Lifestyle V.34 External MODEM
Motorola Power V.34 External MODEM
Orion Telecommunications 14.4 Voice Modem
Pika IdFi Caller ID Card
Pika Inline 4 Voice Card
Practical Peripherals PC288hc V.34 Internal
Practical Peripherals PC288LCD V.FC External
Practical Peripherals PC288MT II V.FC External
Practical Peripherals PC288MT V.34 External
Practical Peripherals PC288MT V.34 Internal
Practical Peripherals PC288MT V.FC External
Practical Peripherals PC288PKT V.FC External
Practical Peripherals PM14400FX V.32bis Internal
Practical Peripherals PM14400FXMT V.32bis External
Prometheus Cyber Stereo PC144ivspa
Prometheus CyberPhone 144VSP External Voice
Prometheus CyberPhone 144VSP Internal Voice
Prometheus CyberPhone 288VSP External Voice
Prometheus CyberPhone 288VSP Internal Voice
Prometheus CyberPort Pro PC288iv/ext
Reveal Quad Office 14.4
Rochelle ANI-232 Caller ID Plug
Rochelle MLA/CIMS232 12-Line Caller ID System
Rochelle Model 20040 MLA 6-Line Caller ID Unit
Rochelle Model 2802 2-Line Caller ID Display
Spectrum V.34 Office F/X
Supra 144i Internal
Supra 144LC External
Supra Desktop Communicator
SupraFAX MODEM 288 External
SupraFAX MODEM 288i Internal
SupraFAXModem 24K
SupraFAXModem V.32bis
TAPI Compliant Hardware Standard Interface
TCI MLX-41 Caller ID Unit
TCI MLX-82 Caller ID Unit
U.S. Robotics Sportster VI 14.4 External Voice
U.S. Robotics Sportster VI 14.4 Internal Voice
U.S. Robotics Sportster VI 28.8 External Voice
U.S. Robotics Sportster VI 28.8 Internal Voice
Ven-Tel CS2001/Comm. Station
Ven-Tel EC 288Fax/Passport 288e
Ven-Tel EC144FaxII/Passport 144e
Ven-Tel PCM 144FaxII/Passport 144i
Ven-Tel PCM 288FaxII/Passport 288i
Vive Call Editor II
Vive RSA-A Caller ID Plug
Vive RSA-I Caller ID Plug
Western Data CryptoCom V32bis/V.34
Western Data Worldcom 144
YES Identifier MLM-2X 2 Line Unit
YES Identifier MLM-4X 4 Line Unit
YES Identifier MLM-8X 8 Line Unit
Zeus Whozz Calling? Four Line Caller ID System



Zeus Whozz Calling? Single Line Device
Zoom ComStar 610
Zoom ComStar 620
Zoom ComStar 623
Zoom FaxModem V.34X
Zoom VFDI 2400/9600
Zoom VFDX External 2400/9600
Zoom VFP    (with Voice) 14400
Zypcom Z32b-RX
Zypcom Z32b-SE
Zypcom Z32b-SED
Zypcom Z32b-SEW
Zypcom Z32b-SX
Zypcom Z32t-RX
Zypcom Z32t-SE
Zypcom Z32t-SED
Zypcom Z32t-SEW
Zypcom Z32t-SX External
Zypcom Z34-RX
Zypcom Z34-SED
Zypcom Z34-SEW
Zypcom Z34-SX
Zypcom Z34-SZ
ZyXEL Elite 2864
ZyXEL Elite 2864L
ZyXEL Omni 288P
ZyXEL Omni 288S
ZyXEL U-1496 Plus External
ZyXEL U-1496B
ZyXEL U-1496B Plus
ZyXEL U-1496E External
ZyXEL U-1496E Plus External
ZyXEL U-1496P Portable
ZyXEL U-1496R
ZyXEL U-1496RE

Many other MODEMs not in this list also support Caller ID.    Most MODEMs that do support 
Caller ID follow the Rockwell standards on software interfaces.    These MODEMs will likely 
work correctly with CallAudit.    If the user’s guide for your MODEM references Caller ID 
support, then enter the suggested setup string in the MODEM Defaults section of the 
System Preferences screens.



Database Conversion
The Database Conversion program converts the existing data in your current CallAudit database to the 
new database format when a CallAudit software update is performed.    Your existing database records 
will all be copied and modified as appropriate for the new database format.    Your existing Notepad data 
files and audiotag sound files will also be converted.

With the release of CallAudit Version 3.0 for Windows 95, there are a number of different situations.    If 
this is a first time installation for 3.0, any existing 2.1 database will be converted to 3.0.    If 3.0 is being 
installed for a second time (as a result of a 3.0 software update), then any existing 3.0 database will be 
converted.    The 3.0 database that is used depends on where CallAudit 3.0 is a 16-bit application for 
Windows 3.X or a 32-bit application for Windows 95.

The normal database name for CallAudit 2.1 is CALAUDIT.MDB.    The normal database name for 
CallAudit 3.0 is CALAUD30.MDB (for the 16-bit version) or CALAUD32.MDB (for the 32-bit version).

When a CallAudit software update is performed, your existing CallAudit database file is renamed. The 
new database has only a small number of default records to support an initial software installation.    The 
records from your old database are then copied, one at a time, into the new database by the Database 
Conversion program. 



DDE Defaults
Dynamic Data Exchange (DDE) is a Windows process for two executing programs to share data and 
information.    CallAudit 2.1 has the capability to act as a DDE client and communicate with other DDE 
servers.    When an incoming or outgoing call occurs, CallAudit can use DDE to notify the other program 
about the number and name of the calling/called party.    

The most common use of this feature is bring up contact records in a Contact Manager such as ACT! 
based on an incoming call processed by CallAudit. See the DDE Support section for more overview 
information about CallAudit support for Dynamic Data Exchange.

Enable automatic PhoneDisc interface
Select this option to have CallAudit automatically look up the name and address for each incoming 
and outgoing call using the PhoneDisc CD-ROM.    This lookup will also occur any time a phone 
number is added or updated in the PhoneBook.      

Note:    You need PhoneDisc version 2.0.11 or later to use the DDE capabilities.    You can 
check you version of PhoneDisc from the PhoneDisc Help menu.    Earlier versions of 
PhoneDisc do not contain any DDE support.    Contact DDA directly to obtain the latest 
version of PDWIN.EXE.

The first time you use this option, you will be prompted to locate the PhoneDisc PDWIN.EXE file.    
CallAudit will automatically start the PhoneDisc program when CallAudit starts, and restart it (if 
necessary) at the time of each incoming call..
Only use this option if you have the PhoneDisc software installed on your PC and wish to have 
CallAudit perform this automatic lookup.
Choosing this option allows you to use PhoneDisc with CallAudit, and still use the remaining DDE 
options to connect with an additional program such as Symantec ACT!.
Selecting this option is all that is required to use CallAudit with PhoneDisc.      The remaining options 



below allow you to specify an additional DDE interface for CallAudit.

Enable automatic Select PHONE ProCD interface
Select this option to have CallAudit automatically look up the name and address for each incoming 
and outgoing call using the Select PHONE ProCD CD-ROM.    This lookup will also occur any time a 
phone number is added or updated in the PhoneBook.      

Note:    This CD-ROM interface uses an ODBC database driver available from Select PHONE 
ProCD.    You must have this ProCD ODBC software installed on your PC before this option 
can be used.    Contact Select PHONE to obtain this software.

Only use this option if you have the Select PHONE ProCD software installed on your PC and wish to 
have CallAudit perform this automatic lookup.
Choosing this option allows you to use PhoneDisc with CallAudit, and still use the remaining DDE 
options to connect with an additional program such as Symantec ACT!.
Selecting this option is all that is required to use CallAudit with PhoneDisc.      The remaining options 
below allow you to specify an additional DDE interface for CallAudit.

DDE Actions - Incoming Calls
Set the Enable DDE toggle button to enable DDE processing for incoming calls.    When this option is 
selected a list of DDE commands will be issued for each incoming telephone call.

Press the Configure DDE Options button to configure how DDE processing is to be performed.

Press the Always prompt before display button to have CallAudit prompt before displaying new DDE
results data from your DDE application.    This setting can be useful when using CallAudit with contact 
managers and databases to avoid having the current record in which you may be working replaced 
with a new record for a new incoming or outgoing call.

Press the Filter out special numbers button to have CallAudit filter out special number from DDE 
processing.    Special numbers include calls listed as Private, Out of Area, and No-CallerID.    This is 
the default option as most DDE programs have no ability to deal with these special numbers. The 
exception to this might be a DDE interface to a paging system where the user wishes to know about all
incoming calls, regardless of Caller ID.

Select the Activate at start of call option to have CallAudit activate the DDE link at the start of an 
incoming call.    This will occur immediately after the first ring when the Caller ID data arrives.

Select the Activate at end of call option to have CallAudit activate the DDE link at the end of an 
incoming call.    This will occur when the incoming call ends.

Note:    The start and end call DDE options are only supported for certain types of multiple line 
Caller ID hardware.    If your hardware does not support this capability, this option will not be 
available.

See the DDE Application Selection    and DDE Incoming Actions sections for more information on 
configuring DDE options.

DDE Actions - Outgoing Calls
Set the Enable DDE toggle button to enable DDE processing for outgoing calls.    When this option is 
selected a list of DDE commands will be issued for each outgoing telephone call placing using 
CallAudit.

Press the Configure DDE Options button to configure how DDE processing is to be performed.

Press the Always prompt before display button to have CallAudit prompt before displaying new DDE



results data from your DDE application.    This setting can be useful when using CallAudit with contact 
managers and databases to avoid having the current record in which you may be working replaced 
with a new record for a new incoming or outgoing call.

See the DDE Application Selection    and DDE Outgoing Actions DdeOutgoingActionssections for more
information on configuring DDE options.

The actions necessary to use the CallAudit DDE option include:

1. Select your DDE action options from the DDE Defaults display in the System Preferences area.

2. Select the Configure DDE option.

3. Select your DDE application program (ACT!, Access, or other Windows program).

4. Select the file to be used with your DDE application program.    Some Windows DDE programs, 
Monologue for example, do not require a file.

5. Select/Edit the command file to be executed for your DDE application program.    This list includes 
the specific DDE commands to be issued by CallAudit to the supporting DDE program.    Specific 
example command templates are supplied for some common DDE programs.    A separate command 
file can be used for incoming and outgoing calls. although both must use the same DDE server.

It is important to note that the DDE command file should be edited based on your selected application. 
Example command files are provided for some other popular Windows programs that support DDE.



DDE Support
CallAudit provides a variety of Dynamic Data Exchange (DDE) support options.    CallAudit can work with
most other external software programs that can act as a DDE server.    A common use of this function is 
with separate contact manager software programs such as Symantec ACT!, GoldMine, or databases 
such as Microsoft Access.

For each incoming and/or outgoing call, CallAudit can issue DDE commands to the external software.    
You can use these commands, for example, to bring up contact data from within your contact manager 
software or load records or forms from your database software.

CallAudit includes standard command templates for some common Windows software programs.    
These templates simply the process of setting up DDE for CallAudit.    Templates are currently provided 
for:

Symantec ACT!
Elan GoldMine
Microsoft Access
Microsoft Excel
PageMaster by Omnitrend
Maximizer for Windows
Monologue for Windows
WinBEEP
Time & Chaos by iBiSTER
PhoneDisc for Windows
Select PHONE ProCD CD-ROM (ODBC interface only)

These template examples can be used to set up command templates for other similar Windows 
programs that can support DDE.    See the DDE with Other Programs section for more information on 
how to connect CallAudit to a third party applications such as Visual Basic.

The basic steps in setting up DDE with CallAudit are as follows:
a. Select Enable DDE from the DDE section of the System Preferences.
b. Press the Configure DDE Options button.
c. Select your desired program from the DDE program selection list.
d. Verify and/or correct as necessary the path to your program’s directory.
e. Press the second Browse button to select your program’s database file.
f. Move to the Incoming Calls tabbed section.
g. Press the Open Examples button and select the DDE file for the selected program 

from the CallAudit directory.
h. Edit the FILE_OPEN line to include the correct path and file name for your programs 

database (this step is only required for some programs).
I. Press the OK button in DDE Program Interfaces Options.    
j. Press the OK button in System Preferences.
k. Exit CallAudit to save all changes.

See the DDE Defaults section of the System Preferences section for more information on configuring 
CallAudit to support DDE.    See the DDE Application Selection section for information on the selection of
the DDE application program to be used.    See the DDE Incoming Actions section for information on 
actions to be performed for each incoming call.    See the DDE Outgoing Actions section for information 



on actions to be performed for each outgoing call.    



DDE Application Selection
The Dynamic Data Exchange (DDE) Application Selection display is used to select the DDE application 
options to be used by CallAudit.    These include the DDE server application to be executed, the 
application file to be used, and the application startup option. See the DDE Support section for more 
overview information about CallAudit support for Dynamic Data Exchange.

See the DDE with Other Programs section for more information on how to connect CallAudit to a third 
party applications such as Visual Basic.

Select your desired options and press the OK button to save your choices.

DDE Program Selection

Use the Program pulldown combo box to select the desired DDE application.    You may select from 
the list of standard DDE application names, or enter your own selection.    When you select an 
included program, default values are automatically inserted for the other fields in this section.

If you use a DDE application not in the combo box, then you must enter the Service, Task, and 
Executable field manually.    The Service field is the name used by DDE services to connect to 
the external application.    The Task field is the task name as reported by Windows.    The 
Executable name is the EXE file name to be executed.

Use the Browse button in the DDE Program section to select the actual DDE application executable 
file to be used.    After your selection both the Executable and Path entries will be completed.

Use the Test button to verify that your selected DDE application executable can be started as 



entered.

Program File Selection

Use the Browse button in the Program File section to select the actual DDE application program file 
to be used.    This file will automatically be loaded each time the DDE application is started.    After 
your selection both the File and Path entries will be completed.    Note that some DDE server 
applications do not require the use of a specific file.

Use the Test button to verify that your selected DDE application file can be loaded as entered.

Start Up Options

Select the Start with CallAudit option if you want the DDE server application to be automatically 
started when CallAudit first starts.

Select the Start with Incoming/Outgoing Call option if you want the DDE server application to be 
automatically started when an incoming or outgoing call begins.    Some DDE applications have a 
long start up time and this may not meet user performance requirements.

Select the Start manually option if you want to start the DDE server application manually.    When 
this option is selected, the CallAudit DDE options will only function when the application is running.    
If a call occurs and the DDE application is not running, then no DDE actions will take place.

Display Options

Select the Minimize at startup option if you want your selected DDE application program to be 
minimized when started.

Select the Restore at time of call option if you want your selected DDE application program to be 
restored to full screen form at the time of an incoming/outgoing call.

Specific DDE Program Notes

Symantec ACT!

NOTE: WHEN USING ACT! WITH CALLAUDIT, ACT! WILL NORMALLY DO A LOOKUP FOR 
EACH INCOMING CALL.    IF A CONTACT RECORD IF NOT FOUND, ACT! WILL PROMPT 
THE USER TO ACKNOWLEDGE THIS FACT.    NO OTHER ACTIONS CAN OCCUR UNTIL 
THIS STEP COMPLETES.    

ACT! Version 2.04 and later can be set up to not display this message.    If you do not have 
ACT! Version 2.04 or later you can download an update from the Symantec BBS.

If you have version 2.04 or later, add the following command to your ACT! DDE template in 
CallAudit.

SetLevel 2

Add this line to the DDE template prior to the LOOKUP command.    This command will turn
off the DDE error messages when a contact record is not located.    The default template 



for ACT! already has this command added.

CallAudit can now automatically add contacts to your ACT! database for callers that are not currently 
in your database.    This is an optional feature that can be turned on or off by using the DDE 
template.

The ACT! DDE template includes three basic commands.    The FILE_OPEN command opens your 
ACT! database.    The LOOKUP command tries to find a record that matches the callers telephone 
number.    The ADD_CONTACT_IF_MISSING command causes CallAudit to add a contact for this 
caller is no record is found.

A second version of this last command, ADD_CONTACT_IF_MISSING_PROMPT, is also included in 
the template, but is commented out.    Use this command instead if you wish to be prompted before 
adding the new contact.

If you use PhoneDisc with CallAudit, the data obtained from PhoneDisc will be used to create the 
new ACT! contact.

When a new contact is added, the following ACT! fields will be initialized with data from CallAudit:

Company
Contact
Phone
Fax
Address
City
State
Zip Code
User 1
ID/Status - filled with CallAudit added record

Monologue for Windows

When using CallAudit with Monologue for Windows, set the Monologue mode for DDE server.    If this
option is not set manually within Monologue, then the CallAudit DDE options will not function.

You can have Monologue speak both the number and name by using the following commands.

$number-monologue
$name

See the DDE Incoming Actions area for information on how to enter these commands.

The CallAudit speak phone number and audio tag sound options should be turned off when using 
Monologue.    When two different programs try to play sounds at the same time. only one will work 
correctly.

PhoneDisc for Windows

When using CallAudit with PhoneDisc for Windows, actual name, and address information will be 
retrieved from PhoneDisc for each incoming and/or outgoing call.    If the current phone number 
record has not been previously edited for this information (name, address, city, state, zip code), then 
any data retrieved from PhoneDisc will be used in the CallAudit phone number record database.

Other programs not listed in the CallAudit options list.



CallAudit can function with most other Windows programs that can act as a DDE server.    The 
CallAudit DDEMGR.INI file contains a variety of variables that can be tailored for use with other 
Windows programs.    These variables are located in the DDE Support section.    Included below, as 
an example, are the default settings for Monologue for Windows.

ProgramName=Monologue for Windows
ProgramExeName=MONOLOGW
FilePath=N/A
FileTitle=N/A
ProgramPath=J:\MONOLOGW
ProgramExePathAndName=C:\MONOLOGW\MONOLOGW.EXE
StartWithCallAudit=1
StartWithCallAction=0
StartManually=0
ServiceName=MONOLOG
TopicName=TALK
TaskName=MONOLOGW
TransactionType=XTYP_POKE

The CallAudit DDE interface can accept values for most of the above variables.    Adding support for 
a new program will involve manually setting correct DDE values for :

ServiceName
TopicName
TaskName
TransactionType

Consult your programs user’ guide for the correct settings for these variables.    See the Advanced 
Section for details on how to specify these values.



DDE Incoming Actions
The Dynamic Data Exchange (DDE) Incoming Actions display is used to select the DDE application 
actions to be performed by CallAudit for each incoming call. See the DDE Support section for more 
overview information about CallAudit support for Dynamic Data Exchange.

The DDE Program section shows the DDE application and program file selected.    See the DDE 
Application Selection section for more information on selecting your DDE application and program file.

Incoming Call Actions

The Use associated telephone number option is used to look up a contact record based on the 
associated telephone number rather than the calling number.    This allows the user the option to have 
a single contact record that is associated with multiple telephone numbers.    When any of the 
associated numbers call, and this option is turned on, the single contact record will be displayed.

The DDE Commands window list the DDE commands to be executed as a result of each new 
incoming call.    Each command is listed on a separate line.    Comment lines can be inserted by 
starting the line with a single or double quote character.
The typical action commands list include entries to close any existing DDE application file, open the 
desired DDE application file, and retrieve information based on the incoming telephone number from 
CallAudit.    Consult your DDE application user’s manual for more information on these and other 
supported DDE commands.
You can reference incoming caller name, telephone number, and other values from CallAudit using the
following variables.

$name The name for the incoming call.



$namechar The name with comma chars removed
$number The telephone number for the incoming call.    The

format includes only the digits with no spaces or 
other formatting characters included.

$number-a The telephone number for the incoming call. The 
format includes the digits in the format XXX-XXX-
XXXX, which is used by ACT! .

$number-space The telephone number for the incoming call.
The format includes the digits in the format XXX 
XXX XXXX, which is used by some programs and 
users.

$number-goldmine The telephone number for the incoming call. The 
format includes the digits in the format (XXX)XXX-
XXXX, which is used by GoldMine.

$number-monlogue The telephone number with one space between 
each digit.    This allows monologue to pronounce 
the number as separate digits.

$number-7 The last seven digits of a 10 digit number
$line The line number for this call
$userfield1 Value for the User 1 data field.
$userfield2 Value for the User 2 data field.
$dtmf Value for the PostCallDtmf field
$date Text format for call date/time
$duration Text format for call duration in seconds
$company Text value for the company field

Note that if you database contains only 7 digit numbers (without the local area code), then you should 
use the $number-7 variable.

Press the Open Examples button to load an example actions command file.    These example files are
loaded when CallAudit is installed and provide examples of common actions for specific DDE 
application programs.

If you use one of the supplied example command files, be sure to edit the parameters to use your 
database file.    For example, the ACT! example makes reference to MYACTDB.DBF.    This parameter 
should be replaced with the name of your ACT! database file.

Press the Test button to test the entered action commands.    An incoming call will be simulated using 
the Mountain Systems support telephone number.    



DDE Outgoing Actions
The Dynamic Data Exchange (DDE) Incoming Actions display is used to select the DDE application 
actions to be performed by CallAudit for each outgoing call. See the DDE Support section for more 
overview information about CallAudit support for Dynamic Data Exchange.

Outgoing Call Actions

The Use associated telephone number option is used to look up a contact record based on the 
associated telephone number rather than the calling number.    This allows the user the option to have 
a single contact record that is associated with multiple telephone numbers.    When any of the 
associated numbers call, and this option is turned on, the single contact record will be displayed.

The DDE Commands window list the DDE commands to be executed as a result of each outgoing 
call.    Each command is listed on a separate line.    Comment lines can be inserted by starting the line 
with a single or double quote character.
The typical action commands list include entries to close any existing DDE application file, open the 
desired DDE application file, and retrieve information based on the outgoing telephone number from 
CallAudit.    Consult your DDE application user’s manual for more information on these and other 
supported DDE commands.
You can reference outgoing caller name and telephone number values from CallAudit using the 
following variables.

$name Provides the name for the incoming call.
$namechar The name with comma chars removed
$number Provides the telephone number for the incoming 

call.    The format includes only the digits with no 



spaces or other formatting characters included.
$number-a Provides the telephone number for the incoming 

call. The format includes the digits in the format 
XXX-XXX-XXXX, which is used by ACT! .

$number-space Provides the telephone number for the incoming 
call.
The format includes the digits in the format XXX 
XXX XXXX, which is used by some programs and 
users.

$number-goldmine Provides the telephone number for the incoming 
call. The format includes the digits in the format 
(XXX)XXX-XXXX, which is used by GoldMine.

$number-monlogue The telephone number with one space between 
each digit.    This allows monologue to pronounce 
the number as separate digits.

$number-7 The last seven digits of a 10 digit number
$line The line number for this call
$userfield1 Value for the User 1 data field.
$userfield2 Value for the User 2 data field.
$dtmf Value for the PostCallDtmf field
$date Text format for call date/time
$duration Text format for call duration in seconds
$company Text value for the company field

Note that if you database contains only 7 digit numbers (without the local area code), then you should 
use the $number-7 variable.

Press the Open Examples button to load an example actions command file.    These example files are
loaded when CallAudit is installed and provide example of common actions for specific DDE 
application programs.

If you use one of the supplied example command files, be sure to edit the parameters to use your 
database file.    For example, the ACT! example makes reference to MYACTDB.DBF.    This parameter 
should be replaced with the name of your ACT! database.

Press the Test button to test the entered action commands.    An incoming call will be simulated from 
the Mountain Systems support telephone number.



Advanced DDE Settings
Use the Advanced Settings dialog to set specific DDE parameters.    Only experienced users 
should attempt to change these settings, as incorrect values will cause the DDE option to 
function incorrectly.

Use the pull down combo box to select the DDE application transaction type.    Only three 
types of transactions are valid.

Enter the DDE topic name in the topic name edit box.    Consult your DDE program’s 
documentation for information about the topic name to use.



DDE with Other Programs 
CallAudit can interface with other Windows programs using Dynamic Data Exchange (DDE). 
This interface can be used with a variety of commercial programs, such as Symantec ACT!, 
or with in-house developed systems such as Visual Basic.

The following is required to use CallAudit with another third party program:

1. Third party program is Windows based
2. Third party program can act as a DDE server
3. Third party program can display results based on DDE commands

The following steps and actions are necessary to establish the interface:

1. Enable DDE in CallAudit
2. Enter third party application specifics
3. Enter third party DDE commands

Enable DDE in CallAudit

1. Select System Preferences from the button bar
2. Select the DDE tab
3. Check the Enable DDE button
4. Press the Configure DDE Options button

Enter third party application specifics

1. Type a program description in the Program field
2. Enter the DDE service name in the Service Name field
3. Enter the windows task name in the Task Name field
4. Use the first Browse button to select the EXE file.    This will fill in both the Executable 

field and the Path field.
5. Press the advanced button
6. Select the DDE transaction type (XTYP_EXECUTE is the most common)
7. Enter the DDE Topic Name to be used (System is the most common)
8. Use the second Browse button to select an input file if your third party application 

requires a separate startup file or database.    Enter blank data here is no file is required.

Enter third party DDE commands

1. Select the Incoming Calls tab



2. Enter the DDE commands to be used in the DDE Commands area

Most applications will only require one or two commands.    The most common action is a 
DDE command to bring up a display in the third party application based on an input 
telephone number.    Some programs will also need a command to open a specific database 
file (the Microsoft Access template supplied with CallAudit is an example of this).    CallAudit
includes a number of data fields that can be used in these commands.    See the Dde 
Incoming Actions section for more information about data fields.

Review the different examples supplied with CallAudit to see how these commands are 
done for standard commercial packages.



MODEM and Comm Port Sharing
Windows communications software programs communicate with hardware devices such as MODEMs 
through Comm Ports.    Examples of Windows communications software include CallAudit, the Windows 
Terminal program (which is located in your Windows accessories folder), and fax software such as 
ProComm Plus and Delrina WinFax Pro.

The normal Microsoft Windows standard is that only one communications software program can access 
a MODEM and communications port at the same time.    If you start ProComm Plus using COM3 and 
then try and run Terminal using the same port, you will get an error message that says “The selected 
Comm Port is in use by another device”.    You must normally exit one program before the other program
can be used.

CallAudit supports port sharing in different ways for the different CallAudit product versions.    These 
options include:

CallAudit 1.0/1.1 - No port sharing supported

CallAudit 2.0/2.1 - 16-bit Windows communications port sharing

CallAudit 3.0 / 16-bit - 16-bit Windows communications port sharing

CallAudit 3.0 / 32-bit - 32-bit port sharing via TAPI

The 16-bit porting sharing option will allow CallAudit to share a MODEM port with another 16-bit 
Windows application.    The details below provides further information on this option.

The 32-bit sharing option will allow CallAudit to share a MODEM port with another 32-bit Windows 
application, as long as both programs are using a TAPI interface.    When both programs use TAPI, port 
sharing is automatic.    When CallAudit detects another 32-bit program is using the same device via 
TAPI, the status line will change to

Telephone line audited and shared

It is generally not possible to share a port between a 16-bit Windows application and a second 32-bit 
application using any current technology.

CallAudit 2.1 offers the option to share a MODEM and communications port with other Windows 
software and avoid this problem.    CallAudit can be executing and auditing your calls and you can still 
use the same MODEM and port to receive or send faxes or data.    This process will also work with voice
mail software allowing CallAudit to audit the call and your existing voice mail software to answer the call 
and take a message.

CallAudit accomplishes this task using a MODEM sharing technology.    When CallAudit starts, it opens 
the selected communications port.    If the port is not in use, CallAudit operates normally.    If the port is 
already open, it “borrows” the port to audit incoming calls and place outgoing calls.    As most all of the 
CallAudit processing occurs before the telephone is answered, there is no conflict with other 
communications programs that either place calls or answer an incoming call.

When a hardware device and communications port are being shared with CallAudit, a number of 
different actions occur.

· Status line will show that the telephone line is shared.
· MODEM will be automatically re-attached to CallAudit software after each incoming call to maintain 

the Caller ID status.



The automatic MODEM re-attachment occurs approximately 5 seconds after the read/write action from 
the other software using the port.    For example if the other software is receiving a fax, the MODEM 
initialization will not occur until the fax is completed and all faxing activity has stopped.

CallAudit attempts to display the telephone line status when port sharing is in effect.    Because other 
communications software may have many options, the status line may not always reflect the true line 
status.

When port sharing is used, some unexpected events can occur with some Windows communications 
software.    WinCim, for example, will sometimes generate a “fake” incoming call event during the 
CompuServe log on process.    This is due to a RING EVENT generated by the MODEM during the 
connection process.

See the MODEM Defaults section of System Preferences to enable this option for CallAudit.

The following describes hints and procedures necessary to use this feature with other popular 
communications software.    

CallAudit starts first:    When sharing a comm port with another windows communications program, be 
sure CallAudit starts first, followed by the other software.    In this way CallAudit can establish the port 
sharing changes before the other software starts.    If CallAudit starts second, the port sharing feature 
may not work correctly.

CallAudit can automatically start the second program after CallAudit completes initialization.    This is 
done by adding a line to the CallAudit INI file (which is located in the Windows directory).    This entry 
includes the complete path name and EXE name for the program to be started.    

For example to have CallAudit start FaxWorks, add the following line to the Defaults section of the 
CALAUDIT.INI file.

SecondProgramPathAndName=C:\FAXWORKS\FAXWORKS.EXE

When CallAudit completes initialization, the FAXWORKS.EXE program will automatically be started.    
An error message will be displayed if the second program fails to start or the path and/or program 
name are invalid.

Note: When using the port sharing option of CallAudit, do not start CallAudit when another 
communication program is running and already processing data (eg. sending or revieving a fax). 
Starting CallAudit at this time will almost always cause the other program abort processing.

Caller ID settings:    If the communications software has the option to enable Caller ID, then use this 
option.    Some communications programs will disable Caller ID for each call, which will cause CallAudit 
not to receive the Caller ID data. Using this option will decrease the potential for conflicts between the 
two programs.    

CallAudit requires that the MODEM echo responses back to the software.    Some communication 
programs turn the echo option off.    If the setup string for your software contains the string component 
E0 (which turns echo off), change it to E1 to turn echo on.

ProComm Plus for Windows, for example, offers the option to enable Caller ID for incoming calls.    
Many other programs offer the option to include your own setup string.    If your program offers this 
option, include the Caller ID command in the setup string.

Most communications programs offer access to the MODEM setup string to be used.    The System 
Preferences portion of CallAudit shows the setup string required to enable Caller ID for your MODEM.  



Use the setup string portion after the AT and add this component to the setup string for the external 
communications software.    The section below describes this process for some popular programs.

CallAudit can attempt to reinitialize the MODEM for Caller ID between each incoming call, but this 
approach should only be used as a last resort.    This process starts about 10 seconds after the call 
completes.    If another call occurs before this reinitialization is completed, the Caller ID data may not 
be available.

Other CallAudit Settings:    When port sharing is being used to allow CallAudit to share a MODEM with
another program, the Use Comm Notify option should be turned off.    This option normally 
speeds program performance, but will cause problems when port sharing is used.    See the 
Other Program Options    section for details on how to configure this option.

Fax software:    Set the software to answer after at least two rings.    If possible, set to answer after three
or four rings to introduce some time separation while CallAudit is finishing the incoming call and before 
the fax software starts to process the fax. 

Voice mail software:    Set the software to answer after at least two rings.    If possible, set to answer 
after three or four rings to introduce some time separation while CallAudit is finishing the incoming call 
and before the voice mail software starts to play the greeting message and process the call. 

ProComm Plus for Windows

ProComm Plus for Windows contains two communications programs, PW2.EXE and FAXSTAT.EXE.    
PW2.EXE is the main program and handles fax and data functions.    FAXSTAT.EXE is a smaller 
program that is only used for sending and receiving faxes.

FAXSTAT.EXE contains a port sharing capability integrated in the program.    If you use the 
FAXSTAT.EXE program by itself (without PW2.EXE also running), be sure CallAudit starts before 
FAXSTAT.EXE.    If FAXSTAT.EXE starts first it will get communications errors when it tries to receive a 
fax.

Add the Caller ID setup string to the string used by ProComm Plus to enable Caller ID.    The Caller ID 
portion is added to the Initialization String in the Caller ID portion of the Data/MODEM Connection 
section.    If for example CallAudit show the setup string as AT#CLS=8#CID=1, then add 
#CLS=8#CID=1 to the string shown in this field in ProComm Plus.

FaxTalk for Windows

Add the Caller ID setup string to the string used by FaxTalk to enable Caller ID.    Be sure the echo 
option is turned on, as the FaxTalk default is E0, which turns echo off.    Use E1 to turn echo on.

Delrina WinFax

WinFax has no known compatibility problems with CallAudit.      Add the Caller ID setup string to the 
setup string used by Delrina WinFax.

Windows Terminal Program

The Windows Terminal program has no known compatibility problems with CallAudit.

FaxWorks 3.0

When using FaxWorks with CallAudit, disable the FaxWorks port sharing option as this will conflict with
the port sharing option of CallAudit.    CallAudit should start first, and then FaxWorks.    If FaxWorks 



starts first, the CallAudit port sharing approach will not work correctly.

Add the Caller ID setup string to the setup string used by FaxWorks.    The Caller ID portion is added to
the Initialization String in the Fax Setup section.    If for example CallAudit shows the setup string as 
AT#CLS=8#CID=2, then add #CLS=8#CID=2 to the end of the string shown in this field in FaxWorks.

Note:    This change in fax setup string is usually not required if your Zoom MODEM also supports 
Distinctive Ring.    Zoom MODEM models with firmware version 2.0 or later offer this hardware 
option.    CallAudit can generally work with FaxWorks versions 3.00f.041 and later without this 
change.

It is suggested that FaxWorks be configured to answer calls after the third ring or later.    Answering 
after the first ring will eliminate the detection of any Caller ID data (which arrives between the first and 
second rings).    Answering on the second ring can cause a CPU conflict as CallAudit is still finishing 
the incoming call details when FaxWorks will be trying to play the greeting message.

Some versions of FaxWorks ship with a different WAV driver called RHSIWAV.EXE.    The use of this 
driver on some systems introduces a conflict with sound processing in CallAudit.    It is suggested that 
the RHSIWAV.EXE not be used when CallAudit is used with FaxWorks.    Most versions of FaxWorks 
supply a program called UNRHSI.EXE that will remove this driver.

QuickLink Message Center Version

Version 2.0.1 (As supplied with Robotics MODEMs)

When using QuickLink Message Center, CallAudit should start first, and then QuickLink.    If 
QuickLink starts first, the CallAudit port sharing approach will not work correctly.    In the 
QuickLink MODEM Setup area, be sure the Caller ID Active option is checked.

It is suggested that QuickLink be configured to answer calls after the third ring or later.    
Answering after the first ring will eliminate the detection of any Caller ID data (which arrives 
between the first and second rings).    Answering on the second ring can cause a CPU conflict as 
CallAudit is still finishing the incoming call details when QuickLink will be trying to play the greeting
message.

CompuServe WinCim

Turn off the Re-init after COM Port sharing option in the Other Program Options dialog.    Using this 
option with WinCim will cause NO CARRIER problems due to the method used by WinCim for opening
a COM port and dialing out.

The Caller ID setup string does not need to be added for this program as WinCim as completely 
closes the port when the connection is completed.

Windows NT 3.5 Users

Windows NT 3.5 allows users to execute standard 16 bit Windows programs.    Windows NT 3.5 offers 
two memory options when 16 bit programs are executed: separate address space and shared address
space.    

When the separate address space option is used with CallAudit, port sharing should be disabled as it 
is not compatible with this option in NT.    

When the shared address space option is used (which means that all Windows 16 bit programs run in 
the same address space), port sharing can be used.    Port sharing in this mode will only work with 



other 16 bit Windows programs.    Port sharing is not compatible with 32 bit Windows NT 
communications programs.

Port sharing in Windows NT requires a MODEM that can generate RING events in NT.    Some 
MODEMs with 8250 UARTs will not generate this signal.    For these MODEMs, port sharing will not 
operate correctly under Windows NT 3.5.

MODEM sharing may not work with all communications programs.    Some program also implement their 
own form of device sharing and may not be compatible with sharing the port with CallAudit.



Sound Defaults

CallAudit can use an attached computer sound board and connected speakers to provide audible 
messages and prompts on the status of the system.    Any sound board capable of playing standard 
Windows .wav sound files will work.    

The Sound portion of the System Preferences section is used to configure which systems sounds will be
used.    The available sound categories include:

· Program Entry/Exit
· Incoming calls
· Database update events
· Outgoing call events
· AudioTag file use
· Speak Phone Number
· New calls alert

These sound options can be turned on or off individually, or all can be turned off using the Enable 
System Sounds toggle button.

The Program Entry/Exit option announces when CallAudit starts and stops.

The Incoming Calls option announces each incoming call.

The Speak Audio Tag option uses any Audio Tag file you may have recorded to further announce an
incoming call

The Speak number if no Audio Tag will speak the telephone number only if no Audio Tag file 
exists.

The Speak Phone Number option announces the caller telephone number for incoming calls.



The Database Update option events announces the results of each update action in the Database 
Details display.

The Outgoing Call Events announces the progress of outgoing calls made with CallAudit when using 
the Dial Out options.

The New Calls Alert option will provide a re-occurring audio prompt if any new calls occur while the 
program is unattended.    This provides an easy mechanism to determine if any incoming calls have 
occurred while you were out.    The number of new calls will be announced approximately every 30 
seconds.    Selecting any option on any window will stop the alert.



MODEM Defaults
CallAudit can support up to two MODEMs or Caller ID capable serial devices.    The first Caller ID device
is always used to audit incoming calls on your primary telephone line.    This telephone line must be 
connected to the first identified serial device or MODEM.    The second MODEM can be used for dial out 
options and/or to audit an additional telephone line.

The CallAudit MultiLine product supports auditing multiple telephone lines using a single primary 
hardware device.    When the multiple line software is used, an additional field to indicate the number of 
lines is also shown.    See the Hardware Specifics section for more information and hints about specific 
multiple line components;

Any MODEM or serial devices used to audit an incoming line must be Caller ID capable.    See the Caller
ID Service section for more details on Caller ID and Appendix A for a list of currently supported devices.

Caller ID MODEM/Serial device

The Caller ID MODEM or serial device is always used to audit incoming calls on your primary 
telephone line.    This device must be Caller ID capable and connected to the telephone line you wish 
to audit.

CallAudit can also use the first device to place outgoing calls, if the device supports this option (most 
all MODEMS do).    Only one device is required by CallAudit.    The first device must support Caller ID 
for CallAudit to provide identification information on incoming calls.

Second MODEM/Serial device

The second MODEM or serial device provides an option to handle two separate telephone lines.    A 
second MODEM can also be used to place outgoing calls on your primary telephone line if your Caller 
ID device does not support outgoing calls (some of the serial devices supported by CallAudit only 
monitor incoming calls and cannot place outgoing calls).    



Your use of a second MODEM device is optional. Select the “Use two MODEM/serial devices” option 
to enable the second device.    Select the “Log incoming calls on separate line” option if you wish to 
have the second MODEM audit incoming calls on a second separate telephone line.      Select the 
“MODEM for placing outgoing calls” option is you wish to use the second device only to place 
outgoing calls.

If should be noted that if both MODEMs or serial devices are connected to the same telephone line, 
the “Log incoming calls” option on the second MODEM should not be selected.    Selecting this option 
in this situation will result in duplicate calls in the Incoming Calls display.

MODEM Parameters

For each MODEM or serial device you must specify the device type, the Windows communications 
port to be used, and the initialization string (if required by the device).    The device type is a pull down 
list that displays the hardware devices currently supported by CallAudit.    You must choose one device
from this list.    If no type is chosen for the first device, CallAudit CANNOT audit incoming calls.

When you installed a serial device in your computer you had to specify it’s communications port.    
After choosing the device type, you must select this same port for CallAudit.    The port numbers 
supported by CallAudit are COM1 through COM9.

When you choose a serial device type, a default initialization string is also selected.    This is the 
default string that generally provides acceptable performance for this device type and CallAudit.    You 
may change this string if you desire.    It should be noted however, that your changes can effect 
whether CallAudit will correctly detect the Caller ID information supplied by the telephone company.    
You should use caution when changing this initialization string.

If you change the string and want to return to the system default, re-select the device type.

Number Lines

The CallAudit MultiLine product supports auditing multiple telephone lines using a single primary 
hardware device.    Use this pulldown menu to select the total number of incoming lines connected to 
the select multiple line Caller ID hardware device.    

First Ring Suppression

Some Caller ID hardware supports the option to suppress the first ring to other telephone devices.    If 
the selected hardware supports this option, the 1st ring suppression option will be available.    
Selecting this option will suppress the first ring to any telephone device connected to the Caller ID 
hardware output.

MODEM and Port Sharing

CallAudit 2.1 supports MODEM sharing with other Windows communications software.    Select the 
“Shared Mode” button if MODEM/Port sharing is desired.    See the MODEM and Comm Port Sharing 
section for more information on MODEM and port sharing.



Caller ID Defaults
CallAudit uses Caller ID information to provide detailed information on your incoming calls.    Without 
Caller ID from your telephone company CallAudit cannot determine the telephone number of incoming 
calls.

Caller ID Options

The Number service option receives only Caller ID number information for incoming calls.    The caller
name will be supplied based on the information in the CallAudit database for this telephone number.

The Number and name service option will use both number and name information as supplied by the
telephone company in the Caller ID string.    The caller name will be displayed in the Incoming Calls 
windows as received through Caller ID.    This option requires that your local telephone company 
support Caller ID name service, and that you have purchased it from them.

The No Caller ID processing option will disable Caller ID processing.    All incoming calls will continue
to be listed in the Incoming calls window, but the number and name will show as Unknown.

Name Display

Select the Data from Telephone Company option to have the name information as supplied by the 
telephone company used for name display in call logs.    This option is only available if you select the 
Number and name service option from above.

Select the Data you entered option to have the name information you entered in the database name 
field used for name display in call logs.    See the Telephone Number Database Details section for 
more information about entering your own name data.

Special note for Zoom 14.4 MODEM users
Recent Zoom 14.4 models now support distinctive ring.    When distinctive ring is enabled,
Caller ID WILL NOT FUNCTION!    You can determine if your Zoom modem supports 



distinctive ring by looking at the Revision number in the SOFMODEM.ID file in the 
FaxWorks directory.    A Revision number of V2.00 or later supports distinctive ring. 
To disable distinctive ring, do the following:

Start the windows terminal program
Open the Zoom modem
Enter the following string                  AT$$R0

This will disable distinctive ring and allow the Caller ID data to be passed to software



Calls Defaults

Incoming Calls
The incoming calls section includes an entry for your local area code, a toggle button for a popup dialog 
for each incoming call, a toggle button to bring the main window to the top of your display on incoming 
calls, a toggle to always open the database details record for an incoming call, a toggle button for 
displaying recent call history in the Incoming Call Detail display, and a maximum number of history 
records to be displayed.

The Local Area Code field is the local area code for your telephone number in your area.    This is used 
as the default value (for telephone number searches) in the Generate Reports area, and to shorten the 
incoming calls audio prompt for calls from within your local area code.

The Default Dial Prefix is the default dial prefix to be used for outgoing calls.    This dial prefix will be 
applied to new telephone numbers created from non-local area code incoming calls.

Select the Popup Summary Dialog check box if you want a popup dialog to occur for each incoming 
call.    An example of the popup dialog is shown below.    The popup dialog window will include the 
time/date of the call, and the number, name, and company associated with the calling party. If this check 
box is selected, the popup dialog will occur even if CallAudit if running in icon mode.

Select the Popup Incoming Dialog check box if you want a popup dialog to occur for each incoming call 
with more detailed information. Use this dialog, for example, if you wish to see the call history for the 
caller for each incoming call.    See the Incoming Call Details section for more details about this dialog 
display.    If this check box is selected, the popup incoming dialog will occur even if CallAudit if running in 



icon mode.

Select the Bring window    to Front check box if you want CallAudit windows to always come to the 
front of your display for incoming calls.    This setting will apply to pop-up dialogs as well as to the 
CallAudit main window.    If you do not select this option and a CallAudit window is covered by other 
windows in your system, when an incoming call occurs the CallAudit window will NOT come to the front 
of your display.

Select the Always Open Details Record check box if you want to see the database details record for a 
telephone number for all incoming calls.    If you only want to see the database details record for 
selected telephone numbers, use the check box described in the Telephone Number Record Details 
section instead.

Select the Always Open Notepad Record check box if you want to see the existing Notepad data for a 
telephone number for all incoming calls.    If you only want to see the Notepad data for selected 
telephone numbers, use the check box described in the Telephone Number Record Details section 
instead.

Note: The Notepad data will pop-up if a Notepad data file has already been created for this number.   
See the Telephone Number Options section for creating a Notepad data file for a specific telephone 
number.    See the next option if you want CallAudit to create a new Notepad data file if one does not 
already exist.

Select the Create new if no file exist check box if you want to have CallAudit automatically create a 
Notepad file if one does not already exist.

Select the Display Call History check box is you always want to see the call history when you select 
the Incoming Call Details display.    The Max History Calls field determines the maximum number of call 
history items to be displayed.    If you do not select this option, you can always recall the call history 
using the Show History button on the Incoming Call Details display.

Use the PhoneBook for new numbers option menu to select the PhoneBook for the numbers of first 
time callers.    Every first time caller has their telephone number added to the CallAudit database.    This 
option determines which PhoneBook will be used.    See the Telephone Number Record Details section 
for more information for changing the PhoneBook of an individual phone number.

Select the Call Blocking Options button to select how calls from selected telephone numbers are to be 
handled.

Outgoing Calls
The outgoing calls section includes a toggle button for re-dial if busy, maximum number of re-dials, and 
time delay in seconds between re-dials.    Use these option to control how outgoing calls are to be 
handled if the called number is busy.

Use the Dial Method to select either Pulse or Tone dialing.    Only choose tone dialing if your MODEM 
supports this option (most current MODEM hardware supports tone dialing).

Use the Default Line to select the default telephone line to be used for outgoing calls.    You can always 
change this option when placing outgoing calls by selecting the desired line.    This option is only used 
when you have two MODEM devices selected for use by CallAudit.    See the MODEM Defaults section 
for more information on using two MODEMs.

The Always open details record and Always open Notepad record choices provide the option to view
the database and Notepad data when placing outgoing calls.    Selecting either of these options will 
effect outgoing calls to all telephone numbers.    If you only want to see the details information for 
selected telephone numbers, use the options shown on the Telephone Number Record Details display.

Selecting the Always open details record will cause the Telephone Number Record Details display to 
be displayed for each outgoing call.    This option allows you to review the complete database details for 
the telephone number being called.



Selecting the Always open Notepad record will cause the Notepad data display to be displayed for 
each outgoing call.    This option allows you to review the Notepad data for the telephone number being 
called.

Select the Phone is connected to MODEM check box if your telephone is connected to the output of 
your MODEM.    If you connect your telephone this way, CallAudit will prompt you to lift the telephone 
received when placing outgoing calls using the DialOut options.    If your telephone is connected directly 
to a wall outlet, this box should not be checked.

When the phone is directly connected to the MODEM, the CallAudit keypad cannot be used, during 
the call process, to enter additional touch tone codes.    This is sometimes desired when dealing with 
voice mail response systems, and with some long distance calls.    If you connect your telephone to 
the MODEM, these extra tones will have to be entered directly from the telephone.

If the phone is not connected to the MODEM, and is connected instead to a wall jack directly, the 
CallAudit keypad or numeric keypad can be used to enter additional touch tone digits.

Select the Outbound Options button to enter outbound dial prefixes that are to be ignored for outbound
dialing.



Confirmation Defaults

The confirmation section controls how database deletions are handled.    Each toggle will instruct 
CallAudit to prompt you before an action is performed.

The Call Deletion toggle will prompt you for confirmation each time you delete a call from either the 
incoming or outgoing calls list.

The Clear All Calls toggle will prompt you any time you delete all calls from either the incoming or 
outgoing calls list.

The AudioTag Deletion toggle will prompt you when you delete the AudioTag File for a telephone 
number.

The Notepad Data Deletion toggle will instruct CallAudit to prompt you any time you delete the 
Notepad data file for a telephone number.

The Telephone Number Deletion toggle will instruct CallAudit to prompt you any time you delete a 
telephone number record from your PhoneBook.



Display Defaults

The main window size section controls how the main window is re-sized to accommodate different sized 
child windows.    

The Manually set window size option forces CallAudit to make no changes to the main window size.    
Any re-sizing must be done by you.

The Adjust to active frame option allows CallAudit to automatically adjust the size of the main window 
to fit the current active child window.    This results in always being able to see the entire child window at 
the expense of having the main window display change size every time you change child windows.

The Enlarge to active frame option allows CallAudit to only enlarge the main window to include the size
of a new child window.    When a smaller child window is chosen, the larger size will remain in effect. 

The Tip of the Day option determines if the Tip of the Day dialog is displayed each time 
CallAudit is started.
The Incoming/Outgoing Call Logs section determines which data fields is displayed in 
the incoming and outgoing calls logs.    Fields that cannot be supported by your hardware 
(e.g. call duration is not provided or supported by all Caller ID hardware) will be disabled.



Configuring System Preferences
CallAudit includes a number of system parameters that determine different aspects of program 
operation.    These areas include:

· System sounds
· MODEM settings
· Caller ID options
· Call processing
· Confirmation settings
· Display options
· DDE options
· Paging options
· E-Mail options

CallAudit includes a separate display for each of these different system preference areas.    These 
displays are tabbed to make it easy to move between different categories of preferences.    Use the 
mouse and press the tab for the desired system preferences area.

In each case you can make changes in any or all of the displays.    Pressing the OK button will save all 
changes made to all displays.    Pressing the Cancel button will cancel all changes made.



Outbound Exclusion Prefixes
When placing outbound calls, long dial prefixes are sometimes required to interface with 
long distance carriers or for other reasons.    CallAudit MultiLine, when used with some 
multiple line Caller ID hardware, can detect and log all outbound calls made from any touch
tone device.    

These long prefixes will look like a long telephone number to CallAudit.    The outbound 
exclusion prefixes are included to deal with this problem.    Any outbound call beginning 
with one of the exclusion prefixes will be edited to remove this data before the telephone 
number is determined.    

Thus if the digits 10288 7039352275 were dialed, and the digits 10288 entered as an 
exclusion prefix, then the number 7039352275 would be reported as the dialed number.    
This offers a more accurate method to track calls.



Hardware Specifics
CallAudit MultiLine supports a variety of multiple line Caller ID hardware.    Included below 
are some specifics and details necessary to support individual components.

TCI MLX-82
The TCI MLX-41 and MLX-82 units should be set for 9600 BAUD, 8 data bits, no parity, and
1 stop bit.



Managing Your Phone Book
CallAudit stores all telephone number information in a relational database.    The Phone Number table 
includes one record for each telephone number known to your system.

The PhoneBook display window can be started by pressing the Phone Book button on the main window 
button bar.    An example of the Phone Book display window is shown below. 

If the current active child window (for example the Incoming Calls Display) has a call item highlighted 
when the Phone Book button is pressed, then this record will be highlighted when the Phone Book 
display appears.
The scrolling list area on the right shows all telephone numbers in the current telephone number 
database.    A count of total records is also shown.

Use the Sort By option to select the way your PhoneBook records are sorted.    You can 
sort by Name, Number, Company, City, State,    Zip code, or User 1.    The default setting is
to sort by name.
Use the Show option to select the subset of total telephone number records to be 
displayed.

Select Show all numbers option to display all telephone numbers. The default setting
is to show numbers.
Select the desired PhoneBook to display number only from that phonebook.

Press the Configure PhoneBooks button to configure the PhoneBooks.
When the PhoneBook is opened, the last values used for Sort By and Show are restored.
The font for the PhoneBook display can also be set and saved.    Use the Edit menu to select
the desired font.    When the program exits, the selected font will be saved and restored at 
the next execution.
CallAudit uses a virtual list technology to manage the size of the Phone Book list display.    Only the 
numbers displayed on the screen are managed inside the Windows memory area.    The size of this list 



is only limited by the hard disk space on your computer and does not have the list limitations imposed on
the Incoming and Outgoing window lists.    As a result, the scrolling of this list and some processing 
options are slower to accommodate an arbitrarily large list.

You can move through the Phone Book record list using the mouse or the keyboard.    Use the Page Up 
and Page Down keys to move up or down one page of records at a time.    Use the up and down cursor 
keys to move up or down by single records.

You can also move to PhoneBook records by entering characters into the phone number list area.    If the
list is sorted by name, then entering the letter S would move to the first record with a name starting with 
the letter S.    If the list is sorted by Company, then the company field is used for comparison when letters
are entered for search.    The type of sort option selected in each case determines the field to be used for
search.

If a next search character is entered within 1 second of displaying the search result, the combination of 
letters is used to locate the record.    For example if the letter S is entered, and then the letter A, then the
first record starting with SA is located and highlighted.

The Options choices area include Call, See Details, and Delete.    The Call button is used to place an 
outgoing call to a selected number.    The See Details button is used to bring up the Telephone Number 
Details record for a single number.    The Delete button is used to delete a single number from the 
database.

An outgoing call may be placed from this screen in two ways:

· Select a number with the mouse and press the Call button
· Select a number with the mouse and press the Dial Out button on the main window button bar

The detail record for a single telephone number can be viewed in two ways:

· Select a number with the mouse and press the See Details button
· Double click on a number with the mouse

A number can be deleted from the number database in a number of ways:

· Select the number with the mouse and press the delete key
· Select the number with the mouse and press the Delete button
· Select the number with the mouse and use the Edit pull-down menu cut option
· Use the delete option on the Number Detail display
· Delete the number as using the Delete Records option in Report Generation

The Search Criteria area is used to search the telephone number database for one or more numbers.    
The initial criteria is copied from the telephone number record for the selected number.      The value for 
the user data field User 1 is also shown in this area.

Pressing the Search button will bring up the Reports Parameters display, which is part of the Generate 
Reports area.    This portion of the software can then be used to search the number database in a more 
comprehensive manner.    See the Generate Reports section for more information on this area.



Configuring PhoneBooks
CallAudit 3.0 support up to 16 user defined PhoneBooks.    Each PhoneBook has a title that 
is used for identification and a description area.

Select the PhoneBook to be changed from the Available PhoneBooks list using the 
mouse.
Enter the PhoneBook title in the Name field.
Enter the description in the Description field.
Press the Update button to save the changes.

CallAudit includes PhoneBook option in the PhoneBook area, the Import area, and the 
Calls portion of System Preferences.



Incoming Call Details
Detailed information on each incoming call, beyond that included on the Incoming Calls display, is stored
in the CallAudit database.    The Incoming Call Details dialog window provides a more detailed summary 
of this information.    You can bring up this call details dialog window for any single call by placing the 
cursor on this call entry in the Incoming Calls Display and double clicking the first mouse button.

The Call Information portion includes additional data about this call, and the data for the associated 
telephone number.    

The Post Call DTMF field shows the keystrokes entered by callers after the telephone is answered.    
This option is only available with the CallAudit multiple line software when used with multiple line 
hardware that captures and reports touch tone digits entered by the caller after the telephone is 
answered.    This field is grayed out for non-supported hardware or calls in which no post call DTMF data
is entered.

The Call Options section provides options to delete this call record, go to the Phone Book database 
display for this telephone number, to Callback this telephone number, or to display the recent incoming 
and outgoing call history for this number.    Incoming and outgoing calls are marked with “In” and “Out” 
respectively.

The DDE Links option button is used to display the user selected application data for the selected call 
record telephone number.    Use this option as a quick way to view the DDE information for any call 
record.

Included at the lower left corner are four buttons to move through the current call records.    These 
include first call, previous call, next call, and last call.    

Included in the upper right area is the call history for this telephone number.    It includes a count of the 
total calls to date from this number as well as a summary of the last few calls.    The maximum number of
calls displayed in the call history details section is a system option that can be changed in the System 
Preferences area.





Outgoing Call Details
Detailed information on each outgoing call, beyond that included on the Outgoing Calls display, is stored 
in the CallAudit database.    The Outgoing Call Details dialog window provides a more detailed summary 
of this information.    You can bring up this call details dialog window for any single call by placing the 
cursor on this call entry in the Outgoing Calls Display and double clicking the first mouse button.

The Call Information portion includes additional data about this call, and the data for the associated 
telephone number.    

The Post Call DTMF field shows the keystrokes entered by callers after the telephone is answered.    
This field is only used for incoming telephone calls.    This option is only available with the CallAudit 
multiple line software when used with multiple line hardware that captures and reports touch tone digits 
entered by the caller after the telephone is answered.    This field is grayed out for non-supported 
hardware or calls in which no post call DTMF data is entered.

The Call Options section provides options to delete this call record, go to the Phone Book database 
display for this telephone number, to Callback this telephone number, or to display the recent incoming 
and outgoing call history for this number. Incoming and outgoing calls are marked with “In” and “Out” 
respectively.

The DDE Links option button is used to display the user selected application data for the selected call 
record telephone number.    Use this option as a quick way to view the DDE information for any call 
record.

Included at the lower left corner are four buttons to move through the current call records.    These 
include first call, previous call, next call, and last call.    

Included in the upper right area is the call history for this telephone number.    It includes a count of the 
total calls to date from this number as well as a summary of the last few calls.    The maximum number of
calls displayed in the call history details section is a system option that can be changed in the System 
Preferences area.





Outgoing Calls Display
The Outgoing Calls Display provides one line of data in a scrolling list for each outgoing call.    An 
example of the Outgoing Calls Display is shown below. 

The displayed data includes time and date of the call, the caller telephone number, and the caller name 
as it exists in your phone book.

CallAudit can also display call duration for certain types of hardware that support call duration 
processing.    If your hardware supports call duration, the display will be expanded to show this data as 
an additional column.

You can move through the display by using the cursor, the Page Up and Page Down keys, or by moving 
the scrolling indicator (the small square box in the scrolling area on the right) directly.    A call item can be
selected with a single mouse click.    A call item can be de-selected with a second single mouse click or 
by pressing the space bar.

If more than one telephone line is being used with CallAudit, an additional column can be shown to 
indicate the line number for outgoing calls.    See the MODEM Defaults section in the System 
Preferences area for more details on using multiple lines with CallAudit.

The Outgoing Calls window title includes a count of the outgoing calls displayed.    An example of this 
text might include:

Outgoing Calls - 14 of 149 calls
This message indicates that 149 calls are in the outgoing calls list and that 14 of these are displayed 
based on the View setting.    Changing the View setting will determine what subset of the total calls are 
to be displayed.    A common setting is View calls By Week, which will only show the outgoing calls for 
the last seven days.

Only calls for the current session are stored in this outgoing list.    A maximum of 1500 calls can be 
stored.    You can further reduce this number using options in the System Preferences area.

Detailed information on each outgoing call, beyond that included on the Outgoing Calls display, is stored 
in the CallAudit database.    The Outgoing Call Details  dialog window provides a more detailed summary
of this information.    You can bring up this call details dialog window for any single call by placing the 
cursor on this call entry and double clicking the first mouse button.
You can review and/or update the information associated with each telephone number by 
selecting a single call record and then pressing the DB Details button on the button bar.    
This action will bring up the Database Details dialog display.



Incoming Calls Display
The Incoming Calls Display provides one line of data in a scrolling list for each incoming call.    An 
example of the Incoming Calls Display is shown below. 

The displayed data includes an icon to show the call type (icon display is available only in CallAudit 3.0   
32-bit version for Windows 95), the time and date of the call, the caller telephone number (if available), 
and the caller name as it exists in your phone book.    

Note: CallAudit 3.0 can also display a variety of other variables.    This can include company, user 
fields, and other data variables.    See the System Preferences Display area to select the variables 
for display.

If Caller ID name service is in effect, the name as supplied by the telephone company can be used.

Note:    In CallAudit 3.0 the Incoming call log display can also display a combination of incoming and 
outgoing calls.    Use the View Menu or the right mouse pop-up menu to select a combined 
incoming/outgoing calls display.

To use the right mouse option (available only in 32-bit version for Windows 95), place the cursor in 
the call log area and press the right mouse button.    Select the Incoming and Outgoing Calls option 
to toggle between the display options.

When the dual display option is used, the call log title will change to Incoming/Outgoing Calls.

See the Caller ID Options section of System Preferences for more information on how to display caller 
name data.

For CallAudit Client operation, the call time/date is determine in one of two ways:

For calls received while the client is connected to the server, the call time/date will be based on the 
client PC clock.

For calls downloaded from the server (which were received while the client was not connected), the 
time/date will be based on the server PC clock.

CallAudit can also display call duration for certain types of hardware that support call duration 
processing.    If your hardware supports call duration, the display will be expanded to show this data as 
an additional column.

The caller telephone number and name can take a variety of values:

Number



10 digit number - Telephone number received by CallAudit as supplied by the telephone company 
Caller ID service.    CallAudit will always force all numbers to be 10 digits, which will include the 
local area code for local callers.

Private - Indicates that the caller has their Caller ID data blocked.    Name will always show as 
Unknown as no name data is provided by the telephone company for these types of calls.     See 
the Private and Out Of Area Calls section for more information about Private calls.
Out of Area - Indicates that the caller if calling from out of the area supported by the telephone 
company for Caller ID.    Name will always show as Unknown as no name data is provided by the 
telephone company for these types of calls.    The most common causes for this situation are 
callers from another state or callers from cellular telephones.    In April of 1995 the FCC has 
mandated that all telephone companies will support Caller ID across state boundaries. .    See the 
Private and Out Of Area Calls section for more information about Out of Area calls.
No-CallerID - Indicates that either no Caller ID data was received, or that the data received was 
invalid or corrupted. Calls that only ring once and complete before the telephone company passes 
the Caller ID data will show as No-CallerID.    The use of a MODEM or serial device that do not 
support Caller ID will show all numbers as No-CallerID as no Caller ID data is ever received.

CallerIdError - Indicates that Caller ID data that was received contained errors.    One cause of this
problem is using a Caller ID device with Number/Name service from the telephone company, when 
the device only supports Number service.

No-DataRcv - Indicates that either no Caller ID data was received, or that the data received was 
invalid or corrupted. Calls that only ring once and complete before the telephone company passes 
the Caller ID data will show as No-CallerID.    Calls with this identifier will usually show an invalid 
date as no valid date/time information was received.

Unknown - Indicates that no Caller ID or other telephone number data was received.

Name
“CallerID Name” - If you have Caller ID name service, the name as supplied by the telephone 
company will be displayed.    Most telephone companies send names in all capital letters and with 
few spaces.    The Number and Name Service option must selected in the Caller ID System 
Preferences section for the telephone company supplied name to be displayed.

Note:    Recent FCC changes have resulted in the implementation of Nationwide Caller ID in 
most areas of the US.    Each telephone company is handing the Caller ID name somewhat 
differently.    Some telephone companies will send the true name of the caller as if it were a local
caller.    Other telephone companies will send the City and State (separated by a comma) of the 
caller in the name field.    Contact your local telephone company to see how this is handled for 
your area.

“PhoneBook Name” - If you do not have caller ID name service, or the Number Only Service 
option is selected in the Caller ID System Preferences section, then the name from the PhoneBook
for this number will be displayed.

Unknown - Indicates that name information for this number is currently available.    This is the case
for first time callers when Caller ID name service is not in effect, and for all Private and Out of Area 
calls.

REJECTED CALL - Indicates a call was received from a telephone number marked in the 
PhoneBook as a rejected call number.    CallAudit will hang up the phone after about 2 rings for any
numbers marked as rejected numbers.

You can move through the display by using the cursor, the Page Up and Page Down keys, or by moving 
the scrolling indicator (the small square box in the scrolling area on the right) directly.    A call item can be
selected with a single mouse click.    A call item can be de-selected with a second single mouse click or 
by pressing the space bar.



The Incoming Calls window title includes a count of the incoming calls displayed.    An example of this 
text might include:

Incoming Calls - 39 of 166 calls
This message indicates that 166 calls are in the incoming calls list and that 39 of these are displayed 
based on the View setting.    Changing the View setting will determine what subset of the total calls are 
to be displayed.    A common setting is View calls By Day, which will only show the incoming calls for the 
current day.

Only calls for the current session are stored in this incoming list.    A maximum of 1500 calls can be 
stored.    You can further reduce this number using options in the System Preferences area.

Detailed information on each incoming call, beyond that included on the Incoming Calls display, is stored
in the CallAudit database.    The Incoming Call Details dialog window provides a more detailed summary 
of this information.    You can bring up this call details dialog window for any single call by placing the 
cursor on this call entry and double clicking the first mouse button.
You can review and/or update the information associated with each telephone number by 
selecting a single call record and then pressing the DB Details button on the button bar.    
This action will bring up the Database Details dialog display.



Auditing Incoming And Outgoing Calls
The CallAudit main window provides separate summary displays for incoming and outgoing calls.

Incoming Calls Summary

The Incoming Calls summary display provides one line of data in a scrolling list for each incoming call.    
An example of the Incoming Calls Display is shown below.

The displayed data includes time and date of the call, the caller telephone number (if available), and the 
caller name as it exists in your phone book.    If Caller ID name service is in effect, the name as supplied 
by the telephone company will be used.

The total incoming calls counts for your current calls list is shown as part of the window title 

Only calls for the current session are stored in this incoming list.    A maximum of 1500 calls can be 
stored.    You can further reduce this number using options in the System Preferences area.

Getting Details on an Incoming Call

Detailed information on each incoming call, beyond that included on the Incoming Calls display, is stored
in the CallAudit database.    The Incoming Call Details dialog window provides a more detailed summary 
of this information.    You can bring up this call details dialog window for any single call by placing the 
cursor on this call entry and double clicking the first mouse button.

Deleting Incoming Calls

After incoming calls are reviewed, they should probably be deleted from the current calls list.    CallAudit 
will automatically delete the oldest calls if the maximum number of calls is reached.    You can delete 
incoming calls by any one of a number of methods.

· Use the Delete Call button on the Incoming Calls Details display
· Select the call using the mouse, and press the delete key
· Select the call using the mouse, and use the cut option in the Edit pull-down menu
· Use one of the other Delete Calls options in the Edit menu

One or more calls can be deleted at one time by using the mouse and the delete key.    If you hold the 
mouse button down and sweep the cursor over one or more calls, each call will be highlighted.    When 
the delete key is pressed, all highlighted calls will be deleted.    You can delete a maximum of 125 calls 
at a time using this method.

Operating in ICON Mode



CallAudit can operate in full display mode or icon mode.    In full display mode the main window is shown
in the main portion of your computer display area.    The size and location are based on your inputs.    All 
incoming summary display information is included as described in the Incoming Calls section.

In icon mode CallAudit is displayed as a single icon usually at the lower left area of your computer 
display.

The text below the icon includes the name of the program and a count of the number of new calls since 
the last time the program was displayed in full display mode.    This mode of operation allows CallAudit to
continue to audit all incoming calls while using only a small portion of your computer display.

The program can be brought back to full display mode by either double clicking on the icon with the 
mouse or selecting the Restore option from the icon menu. 

When an incoming call occurs during the icon mode of operation, a small dialog box can appear above 
the icon with call information only for this call.

This dialog window stays on the screen for approximately 30 seconds and then disappears 
automatically.    See the Call Defaults  system preferences section to select the option to have this popup
dialog appear for each call.

The dialog box includes the date and time for this call in the dialog box title area.    The number, name, 
and company information is displayed in the dialog box based on Caller ID information and data stored 
in your phone book database.

The dialog box also includes a Close button that you can use to close the dialog before the automatic 
timer closes it for you.

The dialog box includes the date and time for this call in the dialog box title area.    The number, name, 
and company information is displayed in the dialog box based on Caller ID information and data stored 
in your phone book database.    The dialog box also includes a Close button that you can use to close 
the dialog box before the automatic timer closes it for you.

Automatic Display of Caller Information

The CallAudit database includes a variety of information about each calling telephone number.    
Additional data about each number can also be stored in a Windows Notepad file.    Each telephone 
number can have a separate Notepad data file.    How you review and edit this information is covered in 
the Phone Book section later in this manual.    

CallAudit includes the option to have this detailed information automatically displayed for each incoming 
call.    This option allows you to see your calling number details on the screen before you answer the call.

Phone Book Information

An example of the information stored in the Phone Book for a single telephone number is shown in 
Database Details display illustrated below.



The Pop-up Phone Number Record check box determines if this display is automatically displayed for 
incoming calls from this number.    

If this box is checked, and the database record updated, then this record will automatically be displayed 
each time a call comes in from this number.

An option in the System Preferences area also includes the choice to have all incoming calls always 
display this data regardless of the setting of the check box.

Notepad Information

An example of the Notepad data for a single number is shown below.

The Notepad window title area includes the name of the Notepad text file for this telephone number.    
CallAudit automatically determines this text file name.    The text in the Notepad file is based on whatever
information you wish to enter for this number.    After data is entered in this display, the Notepad Save 
option in the File Menu should be used to save the information.    When saving this file always use the 
name supplied by CallAudit.



The Pop-up Notepad Data check box determines if the Notepad data for this number is automatically 
displayed for incoming calls.    If this box is checked, and the database record updated, then this 
Notepad data will automatically be displayed each time a call occurs for this number.    

An option in the System Preferences area also includes the choice to have all incoming calls always 
display this data regardless of the setting of the check box.

Getting Details on an Outgoing Call

Detailed information on each outgoing call, beyond that included on the Outgoing Calls display, is stored
in the CallAudit database.    The Outgoing Call Details  dialog window provides a more detailed summary
of this information.    You can bring up this call details dialog window for any single call by placing the 
cursor on this call entry and double clicking the first mouse button.

Deleting Outgoing Calls

After outgoing calls are reviewed, they should probably be deleted from the current calls list.    CallAudit 
will automatically delete the oldest calls if the maximum number of calls is reached.    You can delete 
outgoing calls by any one of a number of methods.

· Use the Delete Call button on the Outgoing Call Details display
· Select the call using the mouse, and press the delete key
· Select the call using the mouse, and use the cut option in the Edit pull-down menu
· Use one of the other Delete Calls options in the Edit menu

One or more calls can be deleted at one time by using the mouse and the delete key.    If you hold the 
mouse button down and sweep the cursor over one or more calls, each call will be highlighted.    When 
the delete key is pressed, all highlighted calls will be deleted. You can delete a maximum of 125 calls at 
a time using this method.

Sort and View Options for Call Summaries
A number of program options exist using the View pull-down menu to sort the actual current calls 
displayed.    You can display only the calls that occurred today, or the last week (actually the last seven 
days), or this month, or this year, or all calls.    If you select the view calls by day option, and CallAudit is 
still running when midnight occurs, the calls in your list will be adjusted accordingly with the new date.

Sort options also exist to sort the displayed calls ascending or descending.    Calls can also be sorted by 
number and name.    In each case a text line will be updated in the title area to reflect the number of calls
displayed and the total number of calls present.    Both the Incoming Calls and the Outgoing Calls 
windows have these sort and view options, and the settings for each are separate.

Printing Call Summaries
The File pull-down menu provides complete options for printing the call summary displays. The Print 
Setup option allows you to select the printer you wish to use.

Options exist for Print Setup, Print Preview, and Print.

You can print a subset of the Incoming and Outgoing call log entries.    First select the desired call log
items, and then the print option.    You can individually select up to 125 call records at a time for 
printing.    If no items are selected, the entire list will be printed.

Use the Help button on these displays for more information about print options.



Telephone Number Database Details
CallAudit stores a variety of information in the database about each telephone number known to your 
system.    An example of the data maintained for each number is shown below.    

The Number Data folder provides detailed information about the selected telephone number.    The 
Options     folder provides additional program options for the selected telephone number.

The fields in the Number Data area can be edited as desired.

Press the Update button to record your changes in the CallAudit database.

If you make changes to the telephone number itself, then the new number will either be updated or 
created as appropriate.

You can delete a telephone number record by pressing the Delete button.

You can add a telephone number record by pressing the Add button.

You can access the data in your DDE program by pressing the DDE Link button.

For DDE programs such as PhoneDisc, this action will retrieve any name and address information for
this telephone number and update the current fields accordingly. If the current values in your record 
for these fields (name, address, city, state, zip) contain anything other than blanks or Unknown, no 
changes will be made.    This allows you to edit desired fields and not have the DDE link changes 
these values.

For other DDE programs such as Symantec ACT!, this action will bring up the contact record from 



that program.    This allows you to access your records in your external program directly from the 
CallAudit PhoneBook records.

Press the Print button to print the current telephone number data.

Included at the bottom left is a single summary line to provide status for each update operation.    Audio 
prompts are also provided as selected in the System Preferences.

Included below is a description of each of the editable fields in the Phone Number Data section.

Telephone Number Field
The first field is the phone number for this record.    It includes an area code as well as seven or 
more digits for the actual number.    The dial prefix field is used if a prefix, such as 1 for long 
distance or 9 for an outside line, is required to dial the number.    The Use Area Code check box 
determines whether the area code portion will be used when placing outgoing calls.    Some areas
of the US require that the area code always be used, even for local numbers, while other areas of
the country will not allow the area code for calls to numbers in your local area.    

This number field is used as the key field in the number database table for all access.    Duplicate 
numbers cannot exist in the database.

Associated Telephone Number Field
The associated telephone number field allows the user to associate the current record with 
another existing telephone number record.    This can be particularly useful when using the DDE 
interface with programs such as Symantec ACT!.    The CallAudit DDEMGR software allows the 
option to connect to the associated telephone number rather than the calling number.    This 
allows the user to direct calls from more than one telephone number to the same telephone 
number information in their DDE support program (such as ACT!).

The default value for this field is ‘None”, which indicates that no number is associated.    If you 
wish to associate with another number, enter the complete 10 digit number (including the area 
code).

Name and Address Information
Additional fields are included for name, company, address, and other related information.    Enter 
data into these fields as you desire.    Any or all can be blank as desired.    

The Caller ID field shows the name information supplied by the telephone company if you have 
Caller ID+ service (which provides both telephone number and name for calling parties).    As this 
data is supplied directly by the telephone company, this field cannot be edited.    If this field is 
blank then no data is being supplied by the telephone company for name information.

A comment field is also included (below the FAX Nnbr area) for up to 255 characters of comment 
data for this telephone    number.    Additional text data for this number can also be entered in a 
Notepad data file.

The date information at the bottom left shows the dates of the last incoming call, the last outgoing
call, and the last time this data was updated.

Unlisted in Phone Book      (only in CallAudit version 2.1 or earlier)
This field determines whether a telephone number will show in your Phone Book display.    
Telephone numbers marked as unlisted will exist in the database, but will not display in your 
Phone Book.    Telephone numbers not marked as unlisted will show in your Phone Book display.

PhoneBook      (only in CallAudit version 3.0)
This field determines in which PhoneBook the telephone number will appear.    See the 
PhoneBook area for more infomration about the multiple phone book options in CallAudit 3.0.

User Data Fields
CallAudit provides two user data fields labeled User 1 and User 2.    You may use these fields to 



include your own data about each telephone number record.    Each field can hold up to 64 
characters of text data.    Enter your desired data and press the Update key to save the edited 
changes to the database.    

The User 1 field is also displayed in the Phone Book search criteria area for the currently selected
number.

Saving Edited Data
Edited data is saved by pressing the Update button in the Phone Number Options area in the 
upper left portion of the display.    A number record can be deleted by pressing the Delete button 
in this same area.    If you enter a telephone number that does not currently exist in your database
and press the Update key, a new record will be created with the data from the fields area.

Status Area
A single line area is included at the lower left to provide status on the current number and most 
recent action.    This status line will be updated each time an action is requested.

Printing your Phone Book Entries
The File pull-down menu provides options for printing the Phone Book.    Options exist for Print Setup, 
Print Preview, and Print.    

The Print Setup option allows you to select the printer you wish to use.

The Print Preview option allows you to view the information before sending it to your printer.

The Print option will print the Phone Book entries.
Use the Help button on these displays for more information about print options.

Display Time
The database details record will stay on the screen for a default length of 30 seconds.    You can 
change this time value to a different value, or set the display to stay on the screen an indefinite 
time until you close it manually.    To implement either of these changes, change the following line 
in the [Defaults] section of the CallAudit INI file (the file is named CALAUDIT.INI and is located in 
your standard Windows directory).

DetailsDisplayTime=15

The numeric value on the right is the number of seconds before the Telephone Number Details 
Record display is automatically closed.    Use a value of 0 to keep the display open indefinitely, 
which means you have to close the window manually.

See the Options     folder for additional program options for the selected telephone number.



Telephone Number Options

The Options folder provides additional program options for the selected telephone number. The Number
Data folder provides detailed information about the selected telephone number.

The fields in the Option area can be edited as desired.    Press the Update button to record your 
changes in the CallAudit database.

AudioTag Data
The AudioTag area determines what audio file is used for incoming calls from this number.    Audio
sounds produced by CallAudit require that your system has a Windows compatible sound card or 
similar device installed.    If this is not the case, then no sounds can be produced by CallAudit on 
your system. If a compatible sound device is installed, then CallAudit can provide audio prompts 
for incoming calls.

If no user supplied AudioTag file exists, then the actual phone number is “spoken” by the program
on incoming calls.    If an Audio Tag file exists, then this file will be played for incoming calls from 
this number.    

If you wish to create an AudioTag file for a number press the Record button.    The Windows 
SOUND.REC is the default recording device used by CallAudit to record AudioTag files.    You 
may use any Windows compatible device that produces XXX.WAV sound files, which is what is 
used by CallAudit. After your AudioTag file is created, it will be used for incoming calls from this 
number.

If an AudioTag file exists for this number, then the Play and Delete button will be active.    The Play



button can be used to listen to the currently stored AudioTag file for this number.    The Delete 
button is used to delete the AudioTag file data for this number.

You can also produce the XXX.WAV audio file to be used for a telephone number with any other 
Window compatible sound recorder device.    You can then use drag and drop to drop your sound 
file on this display window to have it selected as the desired Audio Tag File.    Use the following 
steps for this process:

1) Use your desired sound software to record a WAV sound file.    Any software that produces standard 
windows compatible WAV files will work.

2) Bring up the Telephone Number Record Details display for the selected telephone number.

3) Select the recorded WAV file from File Manager.

4) Use the left mouse button to drag the WAV file from the File Manager to the Telephone Number 
Record Details display.    Release the mouse button when the file is over the Telephone Number 
Record Details display.

Notepad Data
CallAudit includes the option for a separate Windows Notepad text file for each telephone 
number.    This allows you to store up to 32K of additional data about this number in a separate 
area in your own format.

These Notepad files are stored in a special area in the CallAudit directory with a name assigned 
by CallAudit.

Use the Create button to create a Notepad file for this number.    Use the Edit button to edit an 
existing Notepad file.    Use the Delete button to delete the current Notepad file.    The Edit and 
Delete buttons will only be enabled if a Notepad file exists for this number.

Use the Notepad Help option to get additional information about how to enter and edit data in a 
Windows Notepad file.

Incoming Calls Options
The Pop-up Phone Number Record check box determines if this Telephone Number Details 
Record is displayed for incoming calls from this number.    If this box is checked then this 
database record will automatically be displayed each time a call occurs from this number.

An option in the System Preferences area also includes the choice to have all incoming calls 
always display this data, regardless of the setting of the check box.    This allows you to select this
option once for all telephone numbers and always have the Pop-up Phone Number record appear
for each incoming call.

The database record will stay on the screen for a default length of 30 seconds.    You can 
change this time value to a different value, or set the display to stay on the screen an indefinite
time until you close it manually.    To implement either of these changes, change the following 
line in the [Defaults] section of the CallAudit INI file (the file is named CALAUDIT.INI and is 
located in your standard Windows directory).

DetailsDisplayTime=15

The numeric value on the right is the number of seconds before the Telephone Number Details
Record display is automatically closed.    Use a value of 0 to keep the display open indefinitely,
which means you have to close the window manually.

The Pop-up Notepad Data check box determines if the Notepad data for this number is 
automatically displayed for incoming calls.    If this box is checked, and the database record 
updated, then this Notepad data will automatically be displayed each time a call comes in from 
this number.    



An option in the System Preferences area also includes the choice to have all incoming calls 
always display this data regardless of the setting of the check box. This allows you to select this 
option once for all telephone numbers and always have the Notepad Data appear for each 
incoming call.

The Reject Incoming Calls check box determines if incoming calls from this telephone are to be 
rejected.    If this box is checked, then an incoming call from this number will be answered and 
then immediately hung up.    This option allows you to eliminate calls from unwanted telephone 
numbers.    Calls rejected will show the name as REJECTED CALL.

Note:    This option is not possible with some Caller ID hardware devices supported by 
CallAudit.    Serial devices such as the Rochelle ANI-232 Caller ID plug and many other similar
non-MODEM devices do not offer this option.    If this option is not supported by your 
hardware, this field will be disabled.

An option also exists to reject all incoming calls from first time callers.    This feature can be 
advantageous to locations that need to accept incoming calls ONLY from a known set of 
telephone numbers.    When this option is selected, all incoming calls from telephone numbers 
that have not called you before will be rejected.    They will continue to be rejected in the future as 
well until you turn off the “Reject Incoming Calls” option for their number.

This reject all new callers option is selected by adding the following line to the [Defaults] section 
of the CallAudit INI file.    

HangUpOnNewCallers=1

The CallAudit INI file is located in your Windows directory ( which is usually C:\WINDOWS ) and 
the CallAudit INI file name is CALAUDIT.INI.    To add this feature, edit this file and add the above 
line to the [Defaults} section.

An option also exists to reject incoming calls based on partial telephone number strings. Using 
this option for example, the user could block all calls from numbers that start with 703935 or 
21453122, etc.    This allows the user to block all calls from an area code, particular exchange, or 
numbers starting with a subset of digits. Calls rejected using this approach will show the name as 
REJECTED CALL (Blocking.txt).

CallAudit uses a single text file for the source of any number prefixes to be used for blocking.   
This file is named BLOCKING.TXT and should be located in your standard CallAudit directory 
(which is usually C:\CALAUDIT).    See the Call Blocking Prefixes section for more information 
on how to edit this data.

Select the Send E-Mail message option to automatically send an electronic mail message for 
each incoming call from this number.    See the System Preferences E-Mail section for more 
information about setting up your E-Mail connection.

Note: E-Mail is an option only available in CallAudit Version 3.0 or later.    E-Mail 
options are only available when using Windows 95 or Windows NT.

Outgoing Calls Options
The Pop-up Phone Number Record check box determines if this Telephone Number Details 
Record is displayed for outgoing calls from this number.    If this box is checked then this database
record will automatically be displayed each time a call occurs from this number.

The Pop-up Notepad Data check box determines if the Notepad data for this number is 
automatically displayed for outgoing calls.    If this box is checked, and the database record 
updated, then this Notepad data will automatically be displayed each time a call occurs from this 
number.    

Select the Send E-Mail message option to automatically send an electronic mail message for 
each outgoing call for this number.    See the System Preferences E-Mail section for more 
information about setting up your E-Mail connection.



Note: E-Mail is an option only available in CallAudit Version 3.0 or later.    E-Mail 
options are only available when using Windows 95 or Windows NT.



Call Blocking Options
CallAudit can block incoming calls by telephone number, or block all calls from telephone 
numbers not in the PhoneBook database.    The second option is used to enforce security 
where only calls from known numbers are to be accepted.

Select the Block only numbers marked option to block incoming calls from 
individually marked telephone numbers or numbers that match a call blocking prefix.
Select the Block if not in PhoneBook option to block incoming calls from any 
telephone number that is not already in the CallAudit PhoneBook database.



Call Blocking Prefixes

CallAudit includes the option to reject incoming calls based on partial telephone number strings or 
prefixes. Using this option for example, the user could block all calls from numbers that start with 
703935 or 21453122, etc.    This allows the user to block all calls from an area code, particular 
exchange, or numbers starting with a subset of digits. Calls rejected using this approach will show the 
name as ‘REJECTED CALL via prefixes’.

Select the Call Blocking Prefixes option from the Edit menu to edit call blocking prefixes.    Include 
in this list any prefixes that you wish to be blocked.

Press the Save button to save your changes.



Call Costs
CallAudit MultiLine software support call costing.    One or more rate structures can be 
created.    A rate structure consists of six rates, each determining the cost per minute for 
call duration based on the time and day of the call.    Rate values include day, evening, 
night, and weekend day, evening, and night.    See the Call Rates section for more 
information about defining rate structures.

A single rate structure can be applied against a incoming or outgoing call to calculate 
approximate call costs.    Each telephone number can have a default rate structure 
associated.    The Incoming Call Details Call Costs display will show the costs based on the 
current default setting.

Select an alternate rate structure to show the costs for the currently selected call.



Call Rates
CallAudit MultiLine software support call costing.    One or more rate structures can be 
created.    A rate structure consists of six rates, each determining the cost per minute for 
call duration based on the time and day of the call.    Rate values include day, evening, 
night, and weekend day, evening, and night.    See the Call Costs section for more 
information about applying rates to existing incoming and outgoing calls.

Each rate structure includes a rate title and rate description.    All rate values are in $ per 
minute.    Use the Rate Options buttons to create/modify rate information.

Each telephone number can be associated with a single rate structure.    Select the desired 
rate structure and press the Update button (in upper right area of display) to associate the
selected rate structure with the current telephone number.

Rate Options
Press the Add button to add a new rate structure.
Press the Delete button to delete the currently selected rate structure.
Press the Update button to update the selected rate structure with the current data.



Trouble Shooting
If problems arise when using CallAudit consult this users manual or program help files first for 
assistance.    The most common problem areas are described below, along with suggestions to solve 
them.

MODEM Initialization Problems
Consult you MODEM or serial device manual to determine the recommended initialization settings.    
See if these options will solve the problem.    

If you have modified the default initialization string, restore the default value and see if the problem 
persists. See the Installation and Setup or System Preferences sections for more details on MODEM 
setup strings.

In some cases the normal method of establishing communication between CallAudit and your MODEM 
will not work.    The Other Program Options section describes other options for resolving this type of 
problem.

Communications Port Conflicts
The most common cause is that you have assigned two different devices in your computer the same 
communications port number.    This will usually cause a conflict situation.    If this is the case, consult 
your serial device manual to determine how to choose a different communications port.

Communications port conflicts can also arise from assigning the same IRQ to two devices.    This will 
almost always cause problems in Windows.    Any time you make changes to the IRQ assignments for a 
device, be sure the same change in made in the Ports section of the Windows Control Panel.    For 
example if you change the IRQ settings on a MODEM card from IRQ 4 to IRQ 5, make the same change
in the Ports section of the Windows Control Panel.

No Caller ID Information Displays
If telephone calls occur, and all you see on the Incoming Calls display is Unknown for number and 
name, then a problem exists with your MODEM and/or telephone service.

CallAudit requires a MODEM or serial device that supports Caller ID and Caller ID service from your 
telephone company.    If either of these is missing, CallAudit cannot determine the telephone number of 
someone calling your line.    See the Installation and Setup or System Preferences sections for more 
details on MODEM selection.    Contact your telephone company for information on providing Caller ID 
service to your telephone lines.

Use the following steps to test the Caller ID capabilities of your MODEM.

1) Exit CallAudit.

1) Start the Windows Terminal program (usually located in the accessories folder).    You can also use
other data programs such as ProComm+.    Windows 95 users may need to use the Hyper 
Terminal program, as Terminal is not always available.

3) Use the Communications option under the Settings menu to select the Com port for your 
MODEM.

4) Enter the Caller ID setup string (usually AT#CID=1 for most MODEMS).

5) If an error results, your MODEM probably does not support Caller ID.    If OK results, continue.

6) While Terminal is still running, have someone local call you.    Let the telephone ring two or three 
times.    One of two situations will result:

A. The word RING will appear for each telephone ring.    No other data appears.



B. The word RING will appear once.    Three or four other data lines (TIME = 1234, DATE = 1022, 
NMBR = 7039352275, etc) will appear.    The word RING will appear again.

If case A results, your MODEM does not support Caller ID.    If case B results, your MODEM supports 
Caller ID and should work correctly with CallAudit.

If you are using CallAudit with the Whozz Calling? single line device, see the Testing the Whozz Calling?
Single Line Device portion of the Helpful Hints section for more information on how to test this hardware 
device.

Duplicate or Ghost Calls
Duplicate calls (ghost calls) for each incoming call can sometimes occur depending on the 
length of the telephone ring cycle for your telephone company. Ghost calls usually show as 
a second call with the same time and date, but with a No-CallerID telephone number. 
CallAudit uses the length of time from the last telephone ring to determine when an 
incoming call is completed (most all single line hardware such as MODEMs has no other 
means to make this determination).    The normal ring cycle is six seconds (two seconds of 
ring and four seconds of silence) for most telephone systems.    
When CallAudit has not processed a ring event in a fixed amount of time (the default used 
is 8 seconds), then the call is ended.    If your ring cycle is different, or your computer is 
somewhat slow, it may take longer than 8 seconds to complete the overall ring cycle 
processing.    If an incoming call continues to ring, then the next ring will be seen as a new 
call.    As the Caller ID data has already been sent once, it will show as a second ghost call.
If you see this situation, make the following changes:
1. Edit the CallAudit INI file, which is in the windows directory.    This file is CalAud32.INI for 

the 32 bit version and CalAud30.INI for the 16-bit version.
2. Locate the defaults section
3. Change the value of the following line to a larger number

LastRingDelayTime=8
The value is expressed in seconds.    Try a value of 10 or 12 seconds.

System Sounds Don’t Work
You must have a Windows compatible sound board (or similar device) and attached speakers connected
to your computer for sound events to function.    CallAudit cannot produce sound events by using only 
the internal speaker in your computer. See the System Preferences section for more details on system 
sounds.

Phone Book Changes Don’t Take Effect
Be sure you press the update button after any changes are made to the Phone Book Details display.    If 
you make changes, and close the window without pressing the update key, your changes will be lost.

You can also look at the date of last change field to see if you changes are taking effect.    This date is 
updated after each successful database update.

ODBC Errors Appear
If ODBC database update errors appear when performing an update operation, check the SHARE.EXE 
setting in your AUTOEXEC.BAT or CONFIG.SYS file.    Windows 3.1 system need at least 100 locks for 
ODBC updates to work correctly.    Without this change to your system files, no database updates can be
performed.

Additional data is included on the use of SHARE.EXE in the software setup portion of the Installation 
and Setup section.



CallAudit uses a number of dynamic link libraries (DLL) to process database information.    The 
installation and setup process for CallAudit installs a number of ODBC related DLLs in your \WINDOWS\
SYSTEM directory on your hard disk.    If older out of date versions of these same DLLs are present in 
your \WINDOWS directory, then CallAudit may not execute properly.    The most common sign of this 
problem is an “Internal Error” message box when first starting CallAudit.    If this occurs, search through 
your windows directory to see if any of the following files are present:

ODBC.DLL
ODBCINST.DLL
ODBCCURS.DLL
SIMBA.DLL

If any of these files are present in your Windows directory then either rename them or delete them.    
CallAudit needs the correct version of each of these files to be located in the \WINDOWS\SYSTEM 
directory.    These files were copied to the    \WINDOWS\SYSTEM    directory when CallAudit was 
installed.

CallAudit also relies on database related entries in the ODBC.INI file which is located in your \
WINDOWS directory.    The installation and setup process automatically edits this file and attempts to 
insert the correct lines.    If this file was incorrectly formatted before the CallAudit installation began, the 
setup process may not be able to correctly edit the file.    

CallAudit requires two set of lines to be included in the ODBC.INI file.    The first is near the top of the file
and should have the form:

[ODBC Data Sources]
CallAudit=Access Data (*.mdb)

Other similar lines for other programs may also be in this “ODBC Data Sources” section and should not 
be altered or removed.

The second set of lines is usually near the bottom of the file and should have the form:

[CallAudit]
Driver=C:\WINDOWS\SYSTEM\SIMBA.DLL
Description=Access Database for CallAudit
FileType=RedISAM
DataDirectory=C:\CALAUDIT\calaudit.mdb
SingleUser=False
UseSystemDB=False

The “DataDirectory” line in this section should contain the directory location you selected during the 
installation and setup process for CallAudit.

If any of these lines are not in your ODBC.INI file, manually insert them using the Windows Notepad 
editor and try CallAudit again.

Internal ODBC Error
When CallAudit starts, it first reads the valid MODEM list from the CallAudit database.    
Microsoft ODBC software is used for this task.    If old versions of the ODBC.DLL files exist 
within your Windows directory, an “Internal ODBC Error” message will appear.    See the 
ODBC Errors Appear section above for more details on how to solve this problem.

AudioTag Files Don’t Play
A Windows compatible sound device is required to support the playing of AudioTag files.    See Sounds 
part of the System Preferences section for more data. 

If you have a sound device, be sure you save the changes to your AudioTag files when you record them. 



Depending on the recording program you use, the Save option under the File menu is usually the best 
way to save changes. Be sure you DO NOT change either the file name or directory locations as these 
are determined directly by CallAudit.

Notepad Date Doesn’t Get Updated
Any changes you make to a Notepad data file must be saved before the Notepad is closed.    Use the 
Notepad Save option under the File menu    to save your changes.    Be sure you DO NOT change either 
the file name or directory locations as these are determined directly by CallAudit.

Out of Memory Messages
Out of memory messages appear if insufficient memory exists in your system to perform 
the requested operation.    Each program, window and other activity in your system uses 
different types of system memory.    If this message appears, close one or more windows or 
other applications and try the operation again.

Generate Reports Display Scrolls Slowly
Executing a CallAudit report can generate thousands of records.    The Report Generator 
results window uses a virtual list technology to handle an arbitrarily large results set.    One 
side effect of this capability is slower scrolling.    If you move the scroll selector to a 
different position, it can take several seconds for the software to bring your requested data 
into view.

Phone Book Display Scrolls Slowly
The Phone Book can include thousands of records.    The Phone Book window uses a virtual 
list technology to handle an arbitrarily large record set.    One side effect of this capability is
slower scrolling.    If you move the scroll selector to a different position, it can take several 
seconds for the software to bring your requested data into view.

Database Updates Are Slow
CallAudit uses the Microsoft Open Data Base Connectivity (ODBC) standards for all 
database software support .    Any time a database update occurs (such as a telephone 
number update, processing during an incoming call, or adding a telephone number to the 
speed dial set) CallAudit makes calls to ODBC software.    ODBC uses a significant amount of
disk input/output to perform its functions.    
ODBC software runs slow on many systems that have little or no disk cache defined.    The 
DOS program SMARTDRV.EXE is used on many standard Windows systems to configure and 
manage cache memory.    For example a system with little or no cache memory defined, 
may require as much as 10-12 seconds to add a telephone number to the CallAudit speed 
dial list.    The same system will only take 1-2 seconds for the same operation when the 
cache memory is defined.
Additional data is included on the use of SMARTDRV.EXE in the software setup portion of the
Installation and Setup section.

Conflicts With Other Communications Software
CallAudit uses Microsoft windows communications software to “talk” to your MODEM or 
serial device.    It does this by first opening the selected Com Port and then issuing a series 
of setup strings to setup the MODEM up for Caller ID operation.    
Within Microsoft Windows, only one communications software program can open a single 
Com Port at the same time.    If you have FAX software that uses Com Port 2 to answer the 
telephone and accept incoming Fax transmissions, then CallAudit cannot execute using 



Com Port 2 at the same time.    If the Fax software is running when you start CallAudit, you 
will get a “Com Port in Use” error when CallAudit attempts to open the selected Com Port.
To have both programs operating at the same time requires two separate MODEMs or serial
devices.    One for the Fax software and one for CallAudit.    
A single computer can have multiple MODEMs or serial devices.    All can be in use at the 
same time without any adverse effects.    Two or more MODEMs can even monitor the same 
telephone line without any problems.    The key point is that two software programs cannot 
open the same Com Port at the same time.    This applies to Fax software, voice mail 
software and any other windows program that use the standard Microsoft communications 
software interfaces.

Conflicts With QEMM Memory Manager
The Stealth mode of QEMM has been reported to cause problems with the proper operation 
of CallAudit.    When this mode of QEMM is used CallAudit may hang on exit.    If this occurs 
disable this feature of QEMM.

When All Else Fails
CallAudit is developed and marketed by Mountain Systems, Inc.    See the Technical Support section for 
information on how to contact Mountain Systems.



Test Dialog
The test dialog provides a quick way to test your MODEM and sound systems with 
CallAudit.

The Name and Number fields data will be passed to your MODEM as if an incoming call 
from that number had occurred.    Enter the desired Name and Number information and 
press the Test Ring Simulation button to start the process.



Other Program Options
Use this display screen to select other program options dealing with the data 
communications portion of the CallAudit software.    This display is selected by first pressing
the System Preferences button on the button bar, and then choosing the Other Program 
Options item in the Edit menu (the Edit menu is located on the menu bar, not the button 
bar).

The Comm Port Flush option provides an automatic means to keep your MODEM comm port clear of 
unwanted characters that may leak in during long periods of inactivity.    

If you have two telephone lines, activity on one line can cause unwanted characters to appear in the 
input port of the other line.    Similar results can also occur when using some sound utilities and some 
DOS games.    This extra data will cause CallAudit to incorrectly handle incoming call details.
This option allows CallAudit to periodically flush out the incoming data buffer.    Flush actions only occur 
during periods of idle time in your PC and will not interfere with the operation of any other programs you 
may use.    Using this option is the default setting for CallAudit.    

The Period (sec) option determines the frequency of this automatic flush operation.    It can be as short 
as 10 seconds and no larger than 500 seconds.    The default value is 30 seconds.

The Event Delay (msec) option sets a delay value used during the MODEM initialization 
process.    This value introduces a delay at each step of the process to allow the results of 
the previous step to fully complete with the MODEM hardware.    Some MODEMs and/or 
computers need a larger value to establish communications with the MODEM.    The default 
value is 100 msec (1/10 of a second).
The Flush Port at Ring option forces CallAudit to flush the communications port after the 
first ring event.    The option is useful for some hardware situations where line noise can 
cause incorrect characters to be read instead of the Caller ID data.    This option should not 
be used unless problems occur with line noise.    This choice is not available for hardware 
that does not either require or support this option.
The Use Comm Notify option forces CallAudit to only process input from your Caller ID 
hardware when data arrives.    This approach uses the least system resources, but does not 



work for all combinations of hardware, software, and Windows operating systems.    If you 
select this option and experience problems, then disable this choice.    If this option is not 
selected, CallAudit uses a polling approach where the device is polled periodically to see if 
any data has arrived.
The Ring event required to start call option forces CallAudit to only start an incoming 
call when a ring event is received from MODEM devices.    Normally if CallAudit see the RING
string come across the MODEM, a new call is started.    This processing is necessary for 
some MODEMs that never provide ring events.

This option can be useful when using your MODEM with other communications software at
the same time with CallAudit.    Connecting to the Internet or other similar services can 
generate fake calls when the word RING appears.    Turning on this option can avoid these 
problems, and sometimes other communications problems when sharing the MODEM with
other software.

The Re-init MODEM after each call option forces a complete re-initialization of the 
MODEM after the completion of each incoming call.    Some MODEMs (some Boca models for
example) lose their Caller ID initialization after 1-2 incoming calls.    Enabling this option 
forces the CallAudit software to re-initialize the MODEM after each call, and avoiding this 
problem.
The Re-init MODEM after COM Port sharing option forces a complete re-initialization of 
the MODEM (just for the Caller ID portion) after another communications program opens a 
shared port.    Using this option with some communications software (the CompuServe 
WinCim program for example) will result in communications problems.    Use this option only
when it is not possible to add the Caller ID portion of the CallAudit setup string to the other 
communications software program.
The Re-init Delay (sec) option sets a delay value in seconds used during the MODEM re-
attachment and initialization process for shared ports.    This value represents the delay in 
seconds after the last action from the shared communications software before the re-
attachment or re-initialization is performed.



Message Box
The message box is displayed during any CallAudit action that will take longer that a few 
seconds.    This display indicates that CallAudit is busy processing the current event and is 
NOT accepting other user inputs.    Note that the CallAudit menu items are disabled during 
this time period to prevent the user from requesting other events that would conflict with 
the ongoing action.    An example of the message box display is shown below:

The message box includes a central text message indicating the action being performed.    
In many cases a percentage complete progress bar is also included.    This will be updated 
as the processing continues to show the ongoing status of the action.    
The example shown above is when the Outgoing Calls button on the button bar is pressed 
for the first time.    The message indicates that the database information for all current 
outgoing calls is being read one record at a time.    The message indicates that 124 total 
calls are in the current list, that call 89 is currently being processed, and that the action is 
71% complete.



CallAudit Database Repair
All CallAudit data is stored in the CallAudit database.    This database can become corrupted
in various ways.    The most common is a power failure that occurs during a database 
update.    This has the effect of creating a partial record that the software cannot read.

The CallAudit database can be repaired by selecting the Repair Database option from the 
Actions menu available from the Incoming Calls display.    This will repair any existing 
problems.



Technical Support
CallAudit is developed and marketed by Mountain Systems, Inc.    Technical information and support can
be obtained by calling (540) 935-2275.

Further information is also available on the Mountain Systems BBS, which can be reached at (540) 935-
8624.

Mountain Systems can also be reached via the following:

CompuServe:          73140,3510
Internet:                          http://www.naxs.com/mtnsys
E-Mail:                              msi@naxs.com

You can send requests for help or other information to the CompuServe or internet E-Mail 
addresses.    Mountain Systems will respond using the same method.



Pika Base Address Selection
The Pika Base Address Selection dialog is used to set the base addresses for the Pika Caller 
ID card to be used in Windows.    For each Pika Caller ID interface card, select the base 
address used in the AUTOEXEC.BAT file to load the card.    An example of this display is 
shown below.

Select the “Not Used” option for cards 2-4, if the card is not currently installed.



Report Parameters
Report parameters are viewed and edited using tabbed dialogs.    A tabbed dialog exists for Report 
Description, Search options, and Sort and Display options.

An example of the for Report Description dialog is shown below.

The Name field provides a short description of this report.    

The Description field includes up to 255 characters of additional information describing this report.

The Report Title is the heading text that will be displayed above the actual report results.

An example of the for Search options dialog is shown below.



Search Options
The Search Options section includes a number of parameters that determine what records will be 
returned from the CallAudit database.

The Report Type parameter determines whether a report will be generated against the call history 
section of the database or the phone book portion.    The call history tables include entries for all 
incoming and outgoing calls.    

The By xxx toggle button determines whether each of the included fields will be used to select records 
from the database.    

For example using the By Telephone Number choice and the value 703 will retrieve all calls or phone
numbers from area code 703.    If (703) 935-22 is entered, then all calls from numbers beginning with 
70393522 will be retrieved.    Any formatting characters (such as (,    ), or -) are removed from the 
number string before the search is executed.

The wildcard character _ (underscore) is also available to wildcard a single character.    For 
example to retrieve all numbers from area code 703 that end in 123, enter the criteria 703____123 
( digits 703, 4 underscore characters, and digits 123).

Note that special characters such as ‘, “, or other similar format or punctuation characters may 
cause query errors.    Some of these characters have special meaning in SQL and using them in a 
query will generally cause problems.

The By Number Type parameter determines whether listed, unlisted, or associated telephone 
numbers will be included in the report.    

When the associated number option is selected, the report will find all those telephone numbers 
that are associated with the telephone number entered in the By Telephone Number field.    To 
use this option, first enter the desired number in the By Telephone Number field, and then de-
select the By Telephone Number choice.

The By Call Type parameter determines the types of calls that will be retrieved for call history reports. 



The options are for incoming calls, outgoing calls, or both incoming and outgoing calls.    The By Data 
Type option is only available for call history reports.

The By Phone Line option determines the telephone line to be used in retrieving call history records. 
The valid values are Line 1, Line 2, or Line 1+2.    The By Phone Line option is only available for call 
history reports and when two MODEM devices are being used.

The By Date Range option determines the date range for a call history report.    Use this option to 
execute reports for common date ranges such as This Week, Last Week, etc.    

When this option is used, the manual start and stop date options below are not available.

The By Start Date and By Stop Date determine the start and stop dates for reports on incoming 
and/or outgoing calls. .    The By Start Date and By Stop Date options are only available for call history 
reports

Select the By Start Date toggle button to enter a start date.    You can enter the start date directly 
into the date field or use the Calendar option to visually select a start date.    Only records with a 
date greater than or equal to the start date will be retrieved.    An example of the calendar display is 
shown below.

The By User1 parameter determines whether telephone numbers will be retrieved that match the 
User1 search value.

The By Post Call DTMF parameter determines whether call history records will be retrieved that 
match the DTMF search value.    This option is only available with the CallAudit multiple line software 
when used with multiple line hardware that captures and reports touch tone digits entered by the caller
after the telephone is answered.

Select the By Stop Date toggle button to enter a stop date.    You can enter the stop date directly into 
the date field or use the Calendar option to visually select a stop date.    Only records with a date less 
than or equal to the stop date will be retrieved.

An example of the for Sort and Display options dialog is shown below.



Display Options
The Display options section determines what data fields will be displayed in the report result.    Press 
the toggle button beside each field you wish to be included in the report.    The selection of the display 
options will also effect what fields may be exported for use in other external software.

Sort Options
Report records can be sorted on one field in either ascending or descending order.    Select the desired
option using the pull-down menu choices.



Generating Call Reports
CallAudit provides a number of options for generating call reports from the CallAudit database.    Reports
can be generated for incoming calls, outgoing calls, incoming and outgoing calls combined, and the 
phone book.    

For each report you have options for the search criteria, what data fields are to be shown for each 
record, and how the records are sorted.    Once reports are generated they can be viewed, printed, or 
saved to files.    Report definitions can be named and saved to your DOS file system, and recalled at a 
later time for execution.

Creating A New Report
Reports can be created directly in the Reports section or indirectly from other CallAudit software areas 
such as the Phone Book.    

To create a report directly, choose the Reports option from the menu system or press the Reports button
on the button bar.    The initial report screen display is shown below.

A report must be customized, using the Report Parameters screen, before it can be executed.    

The customization step determines the criteria that will be used to search the database, the selection of 
the data fields that will be displayed for the returned database records, how the data will be sorted, and 
the title of the report. 

Executing A Report
Press the Execute button to execute the current report.    This option exists on both the Report 
Generation and the Report Parameters displays.    Execution time can vary depending on the size of 
your database and the search criteria selected.    Message boxes will appear to provide information on 
the progress of the report.    When completed, the results list will include one line for each record 
returned from the database that matched your selection criteria.

CallAudit uses a virtual list technology to manage the size of the Call Reports results list.    Only the 
items displayed on the screen are managed inside the Windows memory area.    The result is the ability 
to handle an arbitrarily large results set without undue memory requirements.



Saving A Report
Once a report is defined through the Report Parameters display, it can be named and saved for later 
execution.    When a report is saved, only the report definition and parameters are saved.    Report 
results are NOT saved with the report definitions.    

Reports are saved in the DOS file system in a special format for CallAudit.    Do not attempt to edit these 
files outside of CallAudit. 

Select the Save As button on the Report Generation window to save the current report.

Opening An Existing Report
An existing report can be recalled for execution.    Press the Open button on the Report Generation 
window to open an existing report.

A single example report is included with the initial CallAudit installation.    Additional reports must first be 
created and stored before they can be used.

Printing Report Results
Generated reports can be printed using the standard Print, Print Setup, and Print Preview options from 
the File Menu.

Exporting Report Results
Once report results are generated, they can be exported for use in other external software.    Select the 
Export Records option from the Action menu to export the current record set.

Exported data is tab delimited with double quotes.    Use the Report Parameters Show section to select 
the fields to be exported.

Deleting Database Records
The records associated with the report results can be deleted from the CallAudit database.    Use the 
Delete Records option from the Edit menu to delete the records for the currently executed report. 

This option can be used to delete call history records or telephone number records.    All records from 
the current report are deleted. 

Once records are deleted they cannot be recalled, so use this option with care.

Adding Report Results to the Auto Dial Callback List
Once report results are generated, they can be added to the Auto Dial Callback List.    Select the    
Records to Auto Dial List option from the Actions menu to add the current record set.



Placing Outgoing Calls
CallAudit can place outgoing calls using the dial capabilities of your MODEM or serial device.    Outgoing
calls can be placed in any of the following ways:

· By pressing the Call button on the current window (many windows include a Call button)
· By pressing the Dial Out button on the main window button bar
· By using the Dial button on the Dial Out window

The Dial Out display is used to manage the placement of outgoing calls.    An example of this display is 
shown below.

Placing a Call

Press the Dial button to place a call to the current telephone number shown.    The Call Status area will 
show the call progress area including call duration.

Double click on any of the speed dial entries to immediately dial that number.    Single clicking on a 
speed dial number will load it into the dial window without dialing.

When the call is completed, press the Hangup button to signal the end of the call.

Entering a Telephone Number

Use the dial pad or keyboard to directly enter a number.    Numbers may be entered as digits, as letters, 
or as a combination of digits and letters.    For example a telephone number entered at 800 CALL JIM 
would result in dialing the number 800 225-5546.    Letter entry will be converted to the correct dial digits 
before the call is placed.

Selecting a Dial Prefix



You can use a dial prefix for specialized telephone features (such as *67, which blocks your telephone 
number in many telephone companies, or 1 to dial long distance).    Dial prefixes can be entered directly 
in the number field, directly in the Dial Prefix field, or selected using the Dial Prefix pulldown option box.  

You can use one of the supplied dial prefixes by selecting from the Dial Prefix pulldown, or by entering 
your desired dial prefix directly in the Dial Prefix field.    Any new dial prefix values you enter directly will 
automatically be added to the prefix list (this data is stored in the prefix.txt file in the CALAUDIT 
directory).    Your new values will be saved and restored each time you use the Dial Out window.

To enter the prefix in the same area as the telephone number, enter this prefix string and separate it 
from the remainder of the number to be dialed with a comma.    Specialized dial prefixes can include the 
* and # keys as well as any combination of digits.    Thus to enable blocking and dial a long distance 
number, you would enter

*67, 1 703 555 1212

Using Dial Out From Other Program Areas

If a telephone number had already been selected when a Call or Dial Out button was selected, then this 
record will be displayed in the Call Information area.    

If no number was selected, the Number field will be blank.    In this case either enter the desired number 
into the field, use the Dial Pad to enter the number, or select a number from the Speed Dial list.    When 
completed, press the Dial button to place the call.    

When the call is placed, the other data fields in the Call Information area will be filled in based on data in
the CallAudit database.    

If the entered telephone number does not exist in the database, one will automatically be created.    If an 
area code was omitted, your local area code will be used and the Use Area Code option will not be 
selected.

Use the Off Hook button to place the MODEM in an off hook state.    Use the Hang-up button to hang-up 
on the current outgoing call.    Use the Dial button to dial the current number.    

The Speed Dial list provides an easy way to place calls to common numbers.    You can place a call to 
any number on the Speed Dial list by double clicking the number with the mouse. Use the Add to Speed 
Dial button to add the current number to the Speed Dial list.    Speed Dial entries may be deleted by 
selecting a single entry and pressing the delete key.

The System Preferences allows you to configure the features that effect outgoing calls.    If a called 
number is busy, CallAudit can continue to dial until the call goes through. See the System Preferences 
section for more information on these options.

Returning An Incoming Call
Incoming calls can be returned directly from the Incoming Calls Display.    Use the mouse to select a 
single incoming call and press the Dial Out button on the main window    button bar.    Incoming calls can 
also be returned by pressing the Callback button on the Incoming Call Details display.

Repeating An Outgoing Call
An outgoing call can be repeated (re-dialed) directly from the Outgoing Calls display.    Use the mouse to
select a single outgoing call and press the Dial Out button on the main window    button bar. 

The settings in the Calls section of the System Preferences display control how outgoing calls are re-
dialed in the case of a busy number.

Outgoing calls can also be returned by pressing the Callback button on the Outgoing Call Details 
display.
MODEM Dial Out Commands
CallAudit uses standard Hayes MODEM commands for placing outgoing calls with the 



MODEM.    The default commands used are ATDTW for tone dialing and ATDPW for pulse 
dialing.    If you wish to use different commands, edit the CALAUDIT.INI file in the Windows 
directory.      The ToneDialString and PulseDialString parameters in the [ModemParms] 
section determine the strings to be used.



Auto Dial Callback List
The Auto Dial Callback List provides a simple means to automate the dialing of a list of 
telephone numbers.    An example of this display is shown below.

Numbers may be added to the auto dial list from the Incoming and Outgoing Calls displays, 
the PhoneBook, and the Reports areas.    Number are added by selecting call records from 
the displays and then pressing the Auto Dial button on the button bar.    All the records 
from a report can be added by selecting the Records to Auto Dial List option from the 
Actions menu.
Numbers can be deleted from the list by selecting one or more numbers and pressing the 
Delete key or Backspace key on the keyboard.
The current status of each number record is show in the last column.    The status options 
are:

Not Called - Indicates this number has not yet been called
Called - incomplete : Indicates this number was called, but the call was 

incomplete
Called - complete : Indicates this number was called and completed

The Name field shows the name of the currently loaded auto dial list.    The Count field 
shows the number of telephone numbers in the list.    The name field can be changed with 
both the Open and Save As buttons.
The Desc field provides an area to enter a description of this auto dial list.    The data 
entered here is saved along with the selected telephone numbers.

Use the Open button to open a previously stored auto dial list.
Use the Save button to save the current auto dial list.    Any changes made to the current 



list will automatically be saved when the auto dial list window closes.
Use the Save As button to save the current auto dial list with a different name.
Use the Clear button to delete all numbers from the current list.
Use the Reset button to reset all numbers to Not Called status.

Use the Dial button to start the auto dial process for the current telephone number list.    
The dial out device to be used is the default device specified in the Call Defaults portion of 
System Preferences.

Each of the telephone numbers in the list will be called.    A popup dialog will be 
displayed to track the call progress for each number as it is being called.    See the Auto 
Dial Status area for more information.
The auto call process will start with the currently selected autodial record.    If, for 
example, you select list item 5, then dialing with start with item 5 and continue to the 
end of the list.    The dialing with then move to the top of the list and move back down to
item 4, which would be the last number called.



Auto Dial Status
The Auto Dial Status dialog shows the progress of the auto dial process.    An example 
display is shown below.    See the Auto Dial Callback List area for more information about 
auto dial options

Use the Hangup button to cancel the current call.
Use the ReDial button to re-dial the current telephone number.
Use the New button to move to the next telephone number in the auto dial list.
Use the Cancel button to cancel the current auto dial process.

When the hangup button is pressed, multiple call status options will be displayed above.    
Select one of the options before proceeding to the next call.

Call was completed - Indicates that the call was completed
Call incomplete - Indicates that the call was not completed and requires further 

action.



Importing Telephone Numbers
The CallAudit information on incoming calls is stored in a relational database keyed on telephone 
number.    This includes name, company, address, and other information that is associated with the 
incoming callers telephone number.    

The first time an incoming call is received from a new telephone number, a record is automatically 
inserted into the database.    Default values (caller name as “Unknown”, etc.) are used for all fields 
except the telephone number.    If Caller ID name service is in effect, the Caller ID name will be used for 
the initial name field.    The user can then edit this record, using the Database Details option, to enter the
appropriate data.

Telephone numbers can be imported into CallAudit from external sources.    This might include word 
processor or Personal Information Managers software, for example.    If you already have telephone 
number information available this data can be imported into the CallAudit telephone number database 
using delimited text files.    All imported data is based on double quoted ASCII strings as input.

Shown below is an example of the Import Telephone Numbers display.

Press the Open button to select the import source file.

Use the Delimiter option to select the type of delimiter used in the input file.

Use the No dial prefix in input and No use area code in input options if you import file includes 
telephone number and does not include the dial prefix and use area code fields.    This is a 
common situation when importing telephone numbers from data sources where the dial prefix and 
use area code data is not stored separately.

Use the Pad 7 digit numbers with local area code option if your input contains telephone 
numbers with only seven digits.    CallAudit stores all numbers as 10 digits, with the area code first.  
Selecting this option will automatically add the local area code to the front of any input number of 
only seven digits.



Press the Import Records button to import records from the currently selected file.

The Import Data Source area allows the user to select the desired import text file.    A record count is 
automatically provided based on an initial scan of the input file.    

The Added Phone Number List section provides a summary of the numbers added from the input text 
file.    You can immediately delete any records added using import by pressing the Delete Imported 
Records button.    

Delimited File Input
The format of this text file should include one line for each telephone number record to be imported.    
The entries should include the following values in the order listed, each enclosed in double quotes.

· Telephone number
· Dial prefix - Note that this field is optional
· Use area code option (either 0 or 1) - Note that this field is optional
· Name
· Company
· Address line one
· Address line two
· City
· State
· Zip code
· Fax Number
· User field 1
· User field 2
· Comment

If any of the fields for a particular telephone number are missing in the import file, or otherwise incorrect,
default values will be used.    Default values are either blank filled or set to Unknown.

The file can be either comma delimited or tab delimited.    A comma delimited file will have each field in 
the record separated by a single comma.    A tab delimited file will have a single tab character that 
separates each field of the record.    

The choice of comma or tab delimited is set by the list box in the Import Data Source area.

An example of a data line for a comma delimited import file is shown below.

"(540) 935-2275", "1", "0", "Mountain Systems"

In this case only four fields (number, dial prefix, use area code option, and name) are imported.      Note 
that each field is further marked by double quotes.

Record Creation
A record is created for each correctly formatted unique telephone number record included in the input 
text file.    Records will not be created for telephone numbers that already exist within CallAudit.    
A summary of the telephone number records added is provided on the display.



Telephone Line Status
The Telephone Line Status dialog is available only with the CallAudit MultiLine software 
product.    This dialog shows the line status when CallAudit MultiLine is used with the Zeus 4
Line Caller ID serial device.

The Line column shows the on/off hook status.    A darkened radio button indicates an off 
hook state.    
The Status column provides more information about the state of the line.    This includes 
on/off hook, ringing, and outgoing/incoming call status. 
The Caller ID column shows the number and name of the party calling/being called.    This 
field is only filled when an incoming or outgoing call is in progress.
The Duration column shows the call duration.    This field is only filled when an incoming or
outgoing call is in progress.    Call duration for incoming calls is measured from off hook to 
on hook.    Call duration for outgoing calls is measured from beginning of ringing to on hook.
The initial position of the dialog is centered on the CallAudit main window.    The dialog can 
be moved to another location and CallAudit will remember its new location each time it is 
re-opened.



Call Notes
The Call Notes display provides a simple means to make notes about a particular 
telephone call.    The note data is stored with the call history can be recalled at any time.    
An edit box is displayed that can contain multiple lines and up to a total of 1024 characters.

Press the Update button to save you changes.
Press the Close button to close the window.



DDE Client Status
The DDE Client Status display shows the status of the Client connection to the CallAudit 
Routing Server.

The Host Selection button is used to specify the host computer on which the CallAudit 
Routing Server software is executing.    This is usually only done once when the Client 
software is first loaded.

The Connect button will attempt a manual connection to the server.

The Disconnect button will disconnect from the server.

The Clear List button will clear the current status display list.



DDE Server Status
The DDE Server Status display shows the status of the Server connections from CallAudit 
Clients.

The Total Client Connections field shows the total number of clients currently connected 
to the server.

The Max Connections field shows the maximum number of clients that can be connected 
to the server.

The Disconnect button will disconnect any currents clients from the server.

The Clear List button will clear the current status display list.



Call Routing Network Configuration
The CallAudit Call Routing Server sends incoming and outgoing call information to CallAudit
Client workstations using Network Dynamic Data Exchange (NetDDE). Dynamic Data 
Exchange (DDE) is one of the few protocols supported by Microsoft for communications 
between two or more Windows programs.    NetDDE is the network version of DDE where 
Windows programs on different computers can communicate.

To use The CallAudit Client/Server software you need two more networked PCs connected 
with network support for NetDDE.    NetDDE support is built into Windows for Workgroups, 
Windows 95, and Windows NT.    Others network service provides may also provide support 
for the NetDDE protocol.

If your current Network software does not support NetDDE, you have a number of choices:

· Contact your network vendor to see if NetDDE support can be added
· Change to a network software package that supports NetDDE
· Install one of the standard Windows packages that include built-in support

The last option is usually the lowest cost route, and represents the least change to your 
system.

If you use Novell network software and have Windows 3.1 PCs, then no built-in support for 
NetDDE will exist (Novell does not support NetDDE at this time).    By upgrading your 
Windows 3.1 PCs to Windows for Workgroups (WFWG 3.11), then the NetDDE support within
WFWG can co-exist with your Novell installation at the same time.    The same result would 
also be obtained by upgrading to Windows 95 or Windows NT.

Windows NT
Using the CallAudit Server software on Windows NT requires a slightly different setup.    
NetDDE support is provided by a combination of software components on the PC.    The 
main Windows applications that handles the NetDDE network communications is 
NETDDE.EXE.    Other components include the NDDEAPI.DLL.    The Windows NT 
NETDDE.EXE program is a 32 bit application for handling NetDDE calls for other 32 bit 
applications in a trusted security configuration. The Windows NT NETDDE.EXE file is usually 
located in the Windows NT system directory, which is named SYSTEM32 on many systems.   
If the Windows NT version of NETDDE.EXE is running, the CallAudit Server will not be able 
to communicate with other client locations.

The current CallAudit software products are 16 bit applications.    When either the Server or 
Client software starts, the software automatically starts the NETDDE.EXE program.    The 
NETDDE.EXE started should not be the Windows NT version, but instead a standard 
Windows 3.11 or Windows 95 version.    The 3.11 or Windows 95 versions are usually stored 
in the WINDOWS directory.

Windows NT offers a number of Services options where system components can be 
automatically started at boot up.    The 2 NETDDE components should NOT BE SET for 



automatic startup.    If the Windows NT components of NETDDE.EXE are started 
automatically, the CallAudit Server will not be able to start the 16 bit version of this 
software.



TAPI Hardware Configuration
The Telephony Application Programming Interface (TAPI) was developed by Microsoft and 
others to simplify the interface between Windows applications and telephone equipment.    
Prior to TAPI, most telephony applications had a separate software interface for each 
separate supported piece of hardware.    For example, supporting voice MODEMs from two 
manufacturers would require two separate software interfaces.    This greatly limited 
software developers as there were more hardware differences than available time and $ to 
modify their applications software.    TAPI was designed to solve this problem as well as 
many more.

Using TAPI on your PC requires at least four things.    The first is a piece of telephony 
hardware (MODEMs, serial devices, actual telephones, complex telephone switches, etc.) 
that supports TAPI.    The second is a Windows application designed to take advantage of 
TAPI.    The third are the Microsoft software components (TAPI.DLL and a few others) needed
to support TAPI.    The fourth is a software component called the Telephony Service Provider 
Interface (TSPI).    If any of these pieces are missing, TAPI cannot be used.    Each of these 
components may in fact include multiple software modules.

The Windows 95 operating system includes an option in Control Panel to configure TAPI.    
Windows 95 ships with this option disabled.    You can enable the Telephony applet in 
Control Panel by doing the following:

1. Use Explorer to move to the Windows System directory.
2. Rename the file TELEPHON.CP$ to TELEPHON.CPL
3. Start Control Panel
4. Double click on the Telephony applet.
5. Configure TAPI as required

The applications software performs the tasks you request by using the TAPI software 
interface to make requests to the Microsoft TAPI.DLL software.    The Microsoft components 
pass those requests on to the hardware specific TSPI modules.    The TSPI software, in turn, 
works with the actual physical hardware to perform the operations.    Examples of this 
process would be tracking incoming telephone calls or placing outbound calls.

Using TAPI hardware and software has many advantages.    One of the first is that software 
configuration is mostly automatic.    TAPI applications will query the hardware to determine 
the features and options that are supported.    It no longer depends on you to determine 
these settings and enter them.    A second advantage is that most TAPI applications can 
share the TAPI hardware with other TAPI compliant software.    This occurs because it is built
in the Microsoft TAPI software components.    Where this feature can cause some problems 
is that most TAPI hardware cannot be shared with non-TAPI applications.    If a standard 16-
bit communications program is using your TAPI MODEM, then no TAPI application will be 
able to access the hardware at the same time.

A small percentage of the hardware on the current market supports TAPI, but a large 
percentage of new equipment will support it.    The TAPI standard deals with many many 
features that can be supported by TAPI hardware.    Virtually every piece of TAPI hardware 
supports a different subset of these possible features.    Two separate MODEMs may support
TAPI, but only one might include support for Caller ID.    Just because the hardware supports
TAPI does not mean it will do all the things you want.    The TAPI support for voice capable 



MODEMs varies even more widely.

Most TAPI compliant hardware components come with their own TSPI software interface.    A
good example is the AT&T 8130 Computer Telephone.    The 8130 supports TAPI and comes 
with it’s own TSPI.    It can support the tracking of both inbound and outbound calls, call 
duration, and placing outbound calls through the telephone.    

Windows 95 can support multiple TSPI packages installed at the same time.    Windows 95 
comes standard with UniModem, a very simple TSPI for the most basic MODEM functions.    
The original TSPI included with Windows 95 DOES NOT support Caller ID.    

Microsoft recently announced the availability of UniModemV for Windows 95, a highly 
improved general purpose TSPI for MODEMs that includes support for both Caller ID and 
voice functions. UniModemV is available today as a download software package from 
different Microsoft sources.    To use UniModemV with your TAPI hardware requires at least 
the following:

· Windows 95
· UniModemV installed
· .inf file installed specific to your TAPI hardware
· TAPI hardware installed in Telephony component within Control Panel

If you intend to use CallAudit with TAPI devices and detect Caller ID, you must 
obtain the new UniModemV from Microsoft.    It is available from their 
CompuServe library, their Internet Web page, directly from Microsoft, or from 
the Mountain Systems BBS.

When using TAPI and UniModemV for Caller ID, incoming Caller ID data may be slower to 
appear.    For normal communications interfaces with MODEMs, the Caller ID data arrives 
shortly after the first ring.    It is almost always displayed by CallAudit prior to the second 
ring.    When using UniModemV for Caller ID, the data is sometimes not sent to CallAudit 
until just after the second ring.    This appears to be a characteristic of UniModemV and is 
not directly related to CallAudit.    You may want to consider this fact in how you set you 
voice mail and/or fax systems for automatic answering.    Setting for 3 rings or more will 
decrease the chance of missing the Caller ID data.

CallAudit Version 3.0 for Windows 95 includes support for 32 bit TAPI.    CallAudit Version 3.0
for Windows 3.X includes support for 16 bit TAPI.    

CallAudit can work with TAPI MODEMs, telephones, and other similar telephone devices to 
track incoming and outgoing calls, place outgoing calls, and other program features.    You 
can select the TAPI mode for CallAudit in the MODEMs section of the System Preferences 
area.    Choose the TAPI device type to use TAPI.    See the TAPI Device Selection area for 
more information about selecting a TAPI device for use with CallAudit.    CallAudit 3.0 
includes no TSPI components as these are almost always hardware specific and supplied by
the hardware manufacturer.

Choosing the TAPI device option will generate a separate hardware list for your PC.    This 
list will show the current hardware installed on your PC that supports TAPI.    Doubling 



clicking on any of these list entries will show additional TAPI properties about this device.    
CallAudit can support up to two devices at the same time and either or both can be TAPI 
based.    Thus if you have two TAPI MODEMs, then each could be used to audit a separate 
telephone line.

All TAPI compliant hardware in your PC should show up in this list.    If your hardware is TAPI 
compliant and does not show, check the following areas:

· Have you installed the hardware specific TSPI component?    This is usually done through 
the control panel using the Telephony applet.

· Have you installed the hardware related software components?    In Windows 95 MODEMs
have to be installed in the MODEMs section for most TAPI software to take advantage of 
their features.

· Can any other TAPI compliant software packages see this hardware?

As stated above, the actual features supported by each piece of TAPI compliant hardware is
different.    For example some TAPI hardware will support on/off hook detection ( which is 
required to accurately track the duration of inbound or outbound calls), while other 
hardware will not.    Some can monitor outbound calls made from extension telephones, 
which others cannot.    The features supported is highly specific to the hardware in use.    
There is currently very little commonality in which features are supported.

When you select a TAPI device for use, CallAudit will query the TSPI software to determine 
which features are supported and which are not.    Different displays and options within 
CallAudit will be disabled if your hardware does not support the feature.    For example if 
your TAPI hardware does not support outbound dialing, then selecting the DialOut window 
in CallAudit will generate an error indicating your hardware does not support dial out.

Note: TAPI support is an option only available in CallAudit Version 3.0 or later.
TAPI options, using Caller ID, are generally only available when used with 
Windows 95.    Windows 3.X does not support the 32 bit TAPI options used by 
the CallAudit 3.0 32 bit application.    
Microsoft has added TAPI support to Windows NT 4.0, but at this time 32 bit 
TAPI is not supported.    The current Beta release of NT 4.0 does include TAPI 
drivers.



TAPI Device Selection
This display is used to select a TAPI hardware device for use with CallAudit.    The list shows 
all the TAPI devices installed in your PC.    The item at the top shows the current device 
selected, if any.    See the TAPI Hardware Configuration section for more information about 
TAPI and the use of TAPI devices.

Click on a TAPI device to select that device for use.
Double click on a TAPI device to see the TAPI properties associated with that device.

The key TAPI features for CallAudit are shown for each device selected.    Features not 
supported by the selected TAPI device will be disabled.

Press the OK button to accept the currently selected TAPI device.
Press the Cancel button to cancel the current selection.

Note: TAPI support is an option only available in CallAudit Version 3.0 or later.    
TAPI options are only available when used with Windows 95.    Windows 3.X 
does not support the 32 bit TAPI options used by CallAudit 3.0.    
Microsoft plans to add TAPI support to Windows NT, but at this time 32 bit TAPI 
is not supported.



Telephone Number Paging
CallAudit can automatically issue pages to your paging system for each incoming and/or 
outgoing call.    CallAudit can work with both DTMF numeric paging systems and alpha-
numeric paging systems.    See the General Paging Information area for more information 
about paging. 

Pages can be generated based on telephone number or for all telephone numbers.    This 
display is used to establish paging by telephone number.

Page Options
Select the Enable paging option to enable paging for this telephone number.
Select the page to be used from the Assigned page Id list.
Edit the details for the selected page by pressing either the Configure button or double 
clicking on the page item.

Page Message Content
This area determines the message to be issued to your pager for calls to/from this 
telephone number.    The message can be a combination of the telephone number, the 
name of the caller, and a separate test component.    Messages to DTMF numeric only 
paging systems should only include numeric data.

Select the Caller Number field to have the caller telephone number used in the page 
message.



Select the Caller Name field to have the caller name used in the page message.
Select the Use Message field to have the entered text used in the page message.    
Enter the desired text in the text area below.    The message text can consist of standard
text and/or variables that reference elements of the call record (caller name, number, 
line, duration, etc).    See the Page Information/Update section for further details on 
supported variables.

Other Paging Options
See the Page Information / Update area for details on editing the parameters associated 
with a single page.
See the Page Status area for information on current pending pages.
See the Paging Defaults section of System Preferences for help on setting up paging 
defaults.
See the General Paging Information area for more information about overall paging. 

Note:    Paging is an option only available in CallAudit Version 3.0 or later.



Paging Defaults
CallAudit can automatically issue pages to your paging system for each incoming and/or 
outgoing call.    Pages can be generated based on telephone number or for all telephone 
numbers.

Incoming Paging Options
Select the Enable Paging option to enable paging for incoming calls.    This option must
be selected for any pages to be issued for incoming calls.

Note: You can quickly enable or disable paging by clicking on the CallAudit frame 
window with the right mouse.
The paging status is show in a small window on the right side of the status bar at the 
bottom of the CallAudit main window.

Select the Enable for all calls option to enable paging for every incoming call.
Select the Filter out special numbers option to filter out special numbers such as No-
CallerID, Private, and Out of Area from generating automatic pages.

The current pages defined within CallAudit are shown in the list box area.    The current 
default page for incoming calls is highlighted.

Select the desired default page by selecting a single page with a single mouse click.
Press the Configure button to configure the currently selected page.
You may also configure a single page with a double mouse click.

Outgoing Paging Options
Select the Enable Paging option to enable paging for outgoing This option must be 
selected for any pages to be issued for outgoing calls.



Select the Enable for all calls option to enable paging for every outgoing call.

The current pages defined within CallAudit are shown in the list box area.    The current 
default page for outgoing calls is highlighted.    

Select the desired default page by selecting a single page with a single mouse click.
You may configure a single page with a double mouse click.

Page Update
Press the Update button to update the parameters for the page parameters for the 
current telephone number.
Press the Test button to generate a test page for the current page and telephone 
number.

Other Paging Options
See the Telephone Number Paging area for details on setting up paging for specific 
telephone numbers.
See the Page Information / Update area for details on editing the parameters associated 
with a single page.
See the Page Status area for information on current pending pages.
See the General Paging Information area for more information about overall paging 
process.

Note:    Paging is an option only available in CallAudit Version 3.0 or later.



Page Information / Update
CallAudit can automatically issue pages to your paging system for each incoming and/or 
outgoing call.    Manual pages can also be sent.    

This display is used to edit the parameters associated with pages.    CallAudit supports both 
numeric and alphanumeric paging systems.

The Available Pages list shows the current pages defined for CallAudit.
Select the desired page from the available pages list to review the page parameters.    The 
key information for most paging systems is the Number, Page #, and Message fields.

Page Parameters
Select the type of paging service using the Paging service type pull down menu.    The
only two options are Numeric (beeper) and Alphanumeric (TAP).    The paging service 
selection will enable only the parameters appropriate for that service.    See the General 
Paging Information section for more information about different types of paging services.

Select the communications Port for the page.    All communications will use this port for 
paging with your MODEM.

Note:    Paging requires exclusive access to the port during page.    The paging 
components uses standard Windows communications and not TAPI.    It this port is in 
use by other software, then pages cannot be sent.    CallAudit will automatically share
the port with paging software.

Select the Baud rate to be used.    The default of 300 baud is sufficient for interfacing 
with most paging systems.    Do not use a different value unless you know your 



paging system requires it.
Select the Init String to be used for your MODEM.    The CallAudit paging software 
already knows how to interface with most MODEMs.    Enter a string here ONLY if you 
experience problems with your MODEM.

Note: If you experience problems with Alpha Numeric paging systems, try using the 
following initialization string:
ATN0%C0~
This string turns off both speed negotiation and data compression, both of which will 
cause problems for some paging systems.    For many paging systems you want to 
connect only at the set speed and you want NO DATA COMPRESSION.    This string will
set these options for most MODEMs.

Select the Dial String to be used for your MODEM.    The CallAudit software already 
knows how to interface with most MODEMs.    Enter a string here ONLY if you experience
problems with dialing on your MODEM.

Note: If you experience problems with paging trying to dial out while your voice mail 
system is still taking a message, use the following dial string:

ATDTW
This will make the MODEM wait for a dial tone before trying to dial out.    If you voice 
mail system is still on the line taking a message, then no dial tone will result and the 
page process will stop and try again later.

Enter your Description for this page.    This can be any text string up to 32 characters.
Enter the telephone Number for your paging system in the Number field.    This is the 
telephone number that will be dialed to reach the paging system.
Enter any Password that is required for your paging system in the Password field.    
Most paging system do not require a password.
Enter the access code for your page in the Page # field.    This is identification for your 
individual pager unit.
Enter the maximum number of characters per paging message in the Message field.    
This value is the maximum number of characters that can be passed as a message to 
your pager.    This can be any combination of numbers and letters.    Note that not all 
paging system support both numbers and letters.
Enter the number of data bits for your paging system in the Data bits field.    The 
default value of 8 is suitable for most paging systems.

Note: If you have problems with Alpha Numeric paging, try setting this value to 7 
data bits.    Some paging systems will only work with a seven data bit setting.

Enter the termination string in the Term string field.    This field is used only for numeric
paging and usually requires no data entry.    Only enter data here if you have problems 
disconnecting from your numeric paging service.
Enter the delay in seconds in the Delay (sec) field.    This field is used only for numeric 
paging and is the delay time between dialing the paging service and entering the 
paging message.    Be sure to enter a sufficient time for your MODEM to dial the paging 
service, the paging service to answer, and issue any bong tones.

Default Message Content
This area determines the message to be issued to your pager.    The message can be a 
combination of the telephone number, the name of the caller, and a separate test 



component.
Select the Caller Number field to have the caller telephone number used in the page 
message.
Select the Caller Name field to have the caller name used in the page message.
Select the Use Message field to have the entered text used in the page message.    
Enter the desired text in the text area below. The message text can consist of standard 
text and/or variables that reference elements of the call record (caller name, number, 
line, duration, etc).
The following variables are available:

$name Provides the name for the incoming call.
$namechar The name with comma chars removed
$number Provides the telephone number for the incoming 

call.    The format includes only the digits with no 
spaces or other formatting characters included.

$number-a Provides the telephone number for the incoming 
call. The format includes the digits in the format 
XXX-XXX-XXXX, which is used by ACT! .

$number-space Provides the telephone number for the incoming 
call.
The format includes the digits in the format XXX 
XXX XXXX, which is used by some programs and 
users.

$number-goldmine Provides the telephone number for the incoming 
call. The format includes the digits in the format 
(XXX)XXX-XXXX, which is used by GoldMine.

$number-monlogue The telephone number with one space between 
each digit.    This allows monologue to pronounce 
the number as separate digits.

$number-7 Last seven digits of a 10 digit telephone number
$areacode Three digit area code from a 10 digit number
$line The line number for this call
$userfield1 Value for the User 1 data field.
$userfield2 Value for the User 2 data field.
$dtmf Value for the PostCallDtmf field
$date Text format for call date/time
$time24 Text format for 24 hour time (eg 1830)
$duration Text format for call duration in seconds
$company Text value for the company field
$address Text value for the address field
$address2 Text value for the address2 field
$city Text value for the city field
$state Text value for the state field
$zip Text value for the zip field



For example to display the name, number, and line number in a page message for an 
incoming call, the following message text would be used:

Call from $name at $number on line $line

This message text would product a paging message of the form:
Call from Mountain Systems at 5409352275 on line 1

Page Creation/Update
Press the Update button to update the parameters for the selected page.
Press the Add button to add the page to the CallAudit database.
Press the Delete button to delete the page from the CallAudit database.

Press the Test button to generate a test page for the current page.
Press the Stop button to terminal the test page.

Other Paging Options
See the Telephone Number Paging area for details on setting up paging for specific 
telephone numbers.
See the Page Status area for information on current pending pages.
See the Paging Defaults section of System Preferences for help on setting up paging 
defaults.
See the General Paging Information area for more information about the overall paging 
process.

Note:    Paging is an option only available in CallAudit Version 3.0 or later.



Page Status

CallAudit can automatically issue pages to your paging system for each incoming and/or 
outgoing call.    This display show the current status of pending and/or completed pages.

Press the Cancel any pending pages button to cancel any current pages that have 
not been completed
Press the Clear all pages button to clear any pages from the system.    Using the option
will erase the history of all current pages.

Other Paging Options
See the Telephone Number Paging area for details on setting up paging for specific 
telephone numbers.
See the Page Information / Update area for details on editing the parameters associated 
with a single page.
See the Paging Defaults section of System Preferences for help on setting up paging 
defaults.
See the General Paging Information area for more information about the overall paging 
process.

Note:    Paging is an option only available in CallAudit Version 3.0 or later.



Sending a Manual Page
Use this display to send a manual page.    The currently defined pages are shows in the list 
box.    To send a manual page do the following:

· Select a page with the mouse
· Edit the message text as desired
· Press the Send button

This will queue the page for sending.    As soon as the line is available the page will go out.

Note:    The message text for the selected page is permanently updated with the 
message text data entered.    

It is suggested that a separate page be created for manual paging to avoid overwriting 
message text data for other automatic pages.    See the Page Information area for more 
information about configuring pages.
You can ad or modify page data by double clicking on any of the pages in the page list.

Other Paging Options
See the Telephone Number Paging area for details on setting up paging for specific 
telephone numbers.
See the Page Information / Update area for details on editing the parameters associated 
with a single page.
See the Paging Defaults section of System Preferences for help on setting up paging 
defaults.
See the General Paging Information area for more information about the overall paging 
process.



General Paging Information
CallAudit can work with both numeric and alphanumeric paging systems.      Numeric 
systems have a simple interface that can be accessed via a standard telephone or from a 
computer.    Most alphanumeric paging systems also support a protocol called TAP that is a 
computer to computer interface.    This options provides the most error free method of 
paging.    If your paging service supports TAP, use this option.

Numeric Paging
Sending a page to a numeric paging service involves a few simple steps:
1) Dial the paging service telephone number
1) Wait a fixed number of seconds
2) Enter the message as a series of touch tone digits
3) Hang up

Note that with this type of paging, little error detection is possible.    The paging number is 
dialed, the software waits a fixed time, and then enters the message and hangs up.

Alpha Numeric Paging

Sending a page to a alphanumeric paging service involves a number of steps that includes 
a variety of error correction:
1) Dial the paging service telephone number
2) Process the computer to computer TAP protocol
3) Enter the alphanumeric message
4) Hang up

You will need to know the following about the paging company of the pager. 

1.    Access Number.    You will need to know the paging terminals alphanumeric paging 
access telephone number.    This is the phone number of the modem at the paging 
company that will receive the message using the TAP protocol.    This number is the same 
for everybody that has a pager from that company.    Many carriers will offer 800 numbers - 
especially the nationwide firms like SkyPage or Mobilcomm.

2.    The baud rate.    You need to know the paging company's modem baud rate associated 
with the access number.    Most access modems still receive alphanumeric messages at 300
baud.    Many have "upgraded" to 2400 baud.    It doesn't really matter that much what rate 
they have - pager messages tend to be relatively short so the speed of transfer is not really
that important.

3.    Characters per message block.    Most paging carriers limit how many characters can be
sent in one message.    A lot of carriers limit the message size to 80 characters.    Many 
others have expanded their service to 230 characters per message.    The size of message 
really becomes a factor of the carrier.    You will need to find out this information or learn 
this through trial and error.



4.    Password?    Does your paging carrier require a password.    Most US companies DO NOT. 
This is the standard way of doing it

1. You will also need to know what port your modem is connected to.    You may need to 
know what kind of modem is attached and perhaps custom configure it by passing a 
modem initialization string.    Generally the standard initialization string is sufficient.

Other Paging Options
See the Telephone Number Paging area for details on setting up paging for specific 
telephone numbers.
See the Page Information / Update area for details on editing the parameters associated 
with a single page.
See the Page Status area for information on current pending pages.
See the Paging Defaults section of System Preferences for help on setting up paging 
defaults.

Note:    Paging is an option only available in CallAudit Version 3.0 or later.



Paging Enable - Disable Time Options
Paging can be automatically enabled or disabled based on the time of the day.    The most 
common situation is where the user wants pages to begin at some point in the morning and
end at some point in the evening.    The Paging Enable - Disable Times dialog is used to 
select these options.

Press the Page only in input time range toggle button to enable the automatic paging 
option.    
Enter the start time in the Paging starts after field.    The time should be entered in the 
format of hh.mm AM/PM.    For example to start paging at 8:30 in the morning, the value 
would be entered as 08:30 AM.
Enter the stop time in the Paging stops after field.    The time should be entered in the 
format of hh.mm AM/PM.    For example to stop paging at 5:30 in the afternoon, the value 
would be entered as 05:30 PM.



E-Mail Defaults
CallAudit includes a variety of Electronic Mail (E-Mail) capabilities.    These include:

Send E-Mail message for each incoming call
Send E-Mail message for incoming calls from selected numbers
Send E-Mail message for outgoing calls from selected numbers
Send user defined E-Mail message

CallAudit can automatically send E-Mail for each incoming and/or outgoing call. E-Mail can 
be sent based on telephone number or for all telephone numbers.

Incoming E-Mail Options
Select the Enable E-Mail option to enable E-Mail for incoming calls.    This option must 
be selected for any E-Mail to be sent automatically for incoming calls.

See the Telephone Number Options section to enable E-Mail for a specific number.
Select the Enable for all calls option to enable E-Mail for every incoming call.
Enter your Microsoft Exchange Settings in the Exchange Settings edit window.
Use the Select button to select the default sender for all automatic E-Mail messages.

You select these entries from the Microsoft Exchange Address Book.
Use the Select button to select the default reeceived for all automatic E-Mail messages.

You select these entries from the Microsoft Exchange Address Book.

Received E-Mail Options
Use this option to have CallAudit alert you when new electronic mail arrives in your 
inbox.



Select the Check for new E-Mail box to have CallAudit automatically check your inbox 
on a periodic basic.

Using this option assumes some facts about your electronic mail connection:
You have a permanent connection to E-Mail where your new messages 
automatically appear in your inbox when they are received.    This is usually only 
the case for network installations where a permanent Internet connection is 
always in force.
Or you use a mail system that automatically checks for new incoming messages 
on a periodic basis.

The Microsoft Exchange package bundled with Windows 95 can do this if the 
Windows 95 Plus is installed.    Microsoft Plus has a variety of Internet tools, 
which includes Internet Mail support.
You can set Exchange up to automatically dial your E-Mail connection on a 
periodic basis.    Any new mail will be placed in your inbox.    CallAudit can then 
detect this new mail and either popup up a dialog or send you a page based on 
the above selections.

To set up this option with Microsoft Exchange do the following:
Select the Services choice from the Tools menu.
Select Properties for Internet Mail.
Select the Connection tab.
Turn off the Work off-line option in the Transferring Internet Mail area.
Press the Schedule button to select you interval for automatic mail check.
Select the Options choice from the Tools menu.

Select the Delivery tab.
Be sure there is a valid value other than None in the first field for the 

location to which new mail is delivered.
Consult the Microsoft Exchange help files for further information.    If you have 
problems setting up this feature, contact your Internet mail service provider for 
further details on dial-up settings necessary for your mail connection.

Enter the Interval in minutes that CallAudit will check your inbox.
Select the Popup Dialog option to have CallAudit alert you with a simple dialog box.
Select the Send page option to have CallAudit send you a page when new mail arrives.
Use the Select Page button to select the page to be used when alerting for new E-Mail.

Note: E-Mail is an option only available in CallAudit Version 3.0 or later.    E-Mail 
options are only available when using Windows 95 or Windows NT.



Tip of the Day
The Tip of the Day option provides hints and comments about CallAudit.    The Tip Of the 
Day option can be set to automatically start each time the program starts, or called up at 
user request.

You can use the View menu to display the Tip of the Day option at any time. 

Press the Next Tip button to see the next tip.
Press the Previous Tip button to see the previous tip
Select the Show tips at startup option to see the Tip of the Day each time the program 
starts.    You can also set this option in the Display section of System Preferences.



Telephone Number Associated Pictures
Each telephone number can have an associated picture.    Pictures are stored in the 
database as a bitmap.    

The maximum size for each bitmap is 250 pixels wide and 200 pixel tall.    If the selected 
bitmap is larger than this size, only the top left portion will be used.

The pictures can be recalled using the right mouse options in the call logs or automatically 
for incoming and/or outgoing calls.    See the Calls portion of System Preferences to set the 
automatic options for picture display.

Press the Open button to select an existing bitmap for this number.
Press the Save button to save the currently selected bitmap for this number.
Press the Delete button to delete the bitmap for this number.




